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Background




The idea for this book evolved from my many years observing and helping Macin-
tosh users. Through my Macintosh-only training, troubleshooting and consulting
business, I've noticed time-and-again how people work too hard at trying to per-
form even the simplest of tasks.

When my wife Sylvia and I are hired, we travel to the customer’s home or business.
I troubleshoot or train and Sylvia types customized, step-by-step procedures on her
iBook. (A copy is printed on her printer and given to the customer when we leave.)
Sometimes a customer is finishing up a computer task or I may ask them to “Drive”
(control the Macintosh) while I guide them as to what needs to be done.

In either case, I occasionally notice a “why did they do it that way” action on their
part. It’s not that these people don’t know what they’re doing — after all, they do
get the job done. Instead, it’s because they were never taught correct steps or no
one has explained that there are various “consistencies” throughout most Macin-
tosh programs.

Because of this, I constantly see people close all their open windows, as an exam-
ple. They do this because they get to a point where they are simply lost. Since they
always close any open windows before shutting down the Macintosh, when they
turn the computer ON, they always see a windowless Desktop. This has become
their familiar starting point. So whenever they become confused, they have to get
back to that “comfort zone”. In doing this however, they waste a LOT of their time
and continue to become frustrated whenever a window is too cluttered or if there
are too many programs open at once.

They never give themselves a chance to explore other things the Macintosh can do
and they almost always use “List View” in all Finder windows. (There’s nothing
wrong with List View but there are times when “Icon View” and “Column View” can
really help in a particular situation.) They seem to feel most comfortable with List
View because this organizes their files and folders into an alphabetical column. A
listing of “A” to “Z” items is what they’re used to — so there’s nothing new to learn.

Most people don’t give themselves the time required to learn this new tool called a
“computer”. I was the same way. Even though Sylvia and I owned an Apple ][+ for



a few years, when we brought our first Macintosh home (the MacPlus, in 1988), I
didn’t want to read any of the manuals. I just wanted to see how the mouse could
control a machine.

During our long and enjoyable journey with the Macintosh, we’ve discovered lots
of subtle but powerful features Apple has painstakingly added to the hardware
and software of each model. When I teach, I teach “habits”. In this book, I show
the consistencies the Macintosh offers and explain how YOU can not only save
time but how you will also gain accuracy and speed in most every Macintosh task
you undertake. These pages will also help you lose the frustration which creeps up
whenever you find yourself not knowing what the Macintosh has just displayed on
the screen.

As a quick example of how to be more efficient — have you ever noticed that your
interactions with the Macintosh are divided between “keyboard-oriented” actions
and “mouse oriented” actions? If you're typing an eMail message, your hands are
on the keyboard. If you're in a Draw or Paint program, your hand will be on the
mouse as you create a design. In either case, what would you do if you wanted to
Print your eMail or Print your design? Do move your hands from the keyboard to
the mouse, so you can pull down the “File” menu and choose “Print...”? Do you
move your hand from the mouse to the keyboard so you can press Command P, in
order to Print?

Since it takes more energy for your brain and muscles to switch from one method
(keyboard and mouse) to the other, simply continue with the method you started
with. If your hands are already typing an eMail message, just use Command P, if
you want to Print. If your hand is already on the mouse when you’re drawing, just
use the mouse to pull down the “File” menu and choose “Print...”.
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Command keys Courtesy of Apple
Option keys
Shift keys
Control keys

The “Command” (or “Apple”), “Shift”, “Option” and “Control” keys are known as
Modifier keys. Holding down one or more of these keys, and using the mouse but-
ton, in various pieces of Macintosh software, can sometimes provide shortcuts or
added features to whatever you are doing.

As a general rule, you’ll be more efficient, if you keep one hand over the Modifier
Keys and the other on the mouse. Use whichever method is more appropriate at
that time: keyboard-shortcut or mouse. (On full-size Macintosh keyboards, usually
this only applies to Apple’s “Desktop Macs”, the Modifier keys will be on both sides
of the Spacebar. So the above technique will work whether you’re left- or right-
handed.)

So let’s see if we can start some new “habits” and get you on a more solid Macin-
tosh-using foundation...
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Join A Macintosh User's Group
Have you ever needed to type a diacritical (pronounciation) mark above a
letter but didn’t know how to do it? Using just about any font, you can ac-
cess these special marks by pressing the Option key and typing a two-step
keystroke. Here’s how it’s done (for this example we’ll create “i”):

1 - Open TextEdit or any program which allows you to enter text.

2 - Hold down the Option key.

3 - Type the letter n then release both keys. (This activates a special two-
step character.)

4 - Now type the letter n, without holding down any other keys.

Here are some other two-step characters:

Option plus...| e u 1 n
then press...| g e u 1 n
produces this: | § é u 1 n

You can also mix the Option key character with other letters, especially the
vowels: 4, &, 1, 0, 1. So, to type pinata, you would type:
p,1, Optionn, n, a, t,a

To see more special characters, follow these steps:

1 - Pull down the Apple menu and choose “System Preferences”.

2 - Click once on “International”.

3 - Click once on “Input Menu”.

4 - Click, to put a checkmark next to “Show input menu in menu bar”.

5 - Now you can pull down the Flag menu from the menu bar and choose
“Show Keyboard Viewer”.

Any key you press is shown on this keyboard. Hold down the Option key

and notice the orange squares. These are the two-step characters. Notice

that just by pressing Option g, you can type this © copyright symbol.
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1la- Using The Keyboard
Do:

While in different programs (Safari, TextEdit, Preview, etc.), pull down the menus
and LEARN the keyboard shortcuts to your favorite or most-used features.

Don't:

Pulling down a menu EVERY time you need to access program features can mean a
lot of extra work for you in exploring which options are stored under which menus.
Even if you know which menu to use, grabbing, then dragging the mouse to the
proper menu is slower than simply pressing a key combination.

Explanation:
There are 2 observations you should notice here:

OBSERVATION 1
Look at the top-left corner of the screen. Notice that whichever program you are
using, the “Apple” menu is always in the upper-left corner. The menu just to the
right of the “Apple” menu is called the “Application” menu. This menu name will
change and show the name of the program you are currently using. To the right of
this menu, you’ll usually find the “File” and then the “Edit” menus.

These four menus give you a consistency throughout your Macintosh usage. Be-
cause of these stable items, you have a good starting point for learning the key-
board shortcuts to common Macintosh features.

A keyboard shortcut is when you press one or more keys in order to activate a spe-
cific feature — print, quit, save, etc.

OBSERVATION 2
Open different programs and pull down these four menus. Notice that some of the
common features have the same keyboard shortcuts. This means, if you learn the
keyboard shortcut for printing, while in Safari, you can use this same keyboard
shortcut whenever you want to print from TextEdit.
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For example, pull down the “File” menu and make a note of the keyboard shortcut
for “Quit”.

NOTE: There is no “Quit” while you’re in the “Finder”. The Finder is part of
the Operating System — the software which controls all the major
functions of the Macintosh. This means you cannot quit the Finder
because it’s the foundation for just about everything you can do
with a Macintosh.

Let’s say you are in Safari when you pull down the “File” menu. To the right of the
words “Quit Safari” you’ll see this symbol:

36

This same design is on the keys which are located to the right and left of the Space-
bar on your Apple keyboard. This is called the “Command” key. (Also called the
“Apple” key.)

LLELLLETLLL].]

r--

Command keys Courtesy of Apple

In order to use the keyboard to quit a program, do the following;:
1- Hold down the “Command” key.
2 - While the “Command” key is still down, touch the letter “q”.

({2

3 - Release both keys once the letter “q” is pressed.

«©

To print, using only the keyboard, simply substitute the letter “q”, in the above

[{3e]

steps, with the letter “p”.



Here is a little keyboard trivia:

« The “Command” key is just one Modifier Key — Option, Shift and Control are
also Modifier Keys.

« Sometimes it takes 2, 3 or even 4 key presses at the same time to activate a
specific program feature.

« No matter how many keys must be pressed to activate a feature, those keys
represent a Keystroke.

« Here are some Modifier Keys symbols and which keys they represent:

Command 3@ Escape \‘ >
Option -\: Delete@

Control N\
Shift ﬁ
Enter 7\

Caps Lock g o— ‘_)

Comments:
Become familiar with some of the keyboard shortcuts available to you. They can
sometimes save you a lot of time and guess work.
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Join A Macintosh User's Group
Whether you’re a beginner or an expert, a Macintosh user’s group can offer
lots of resources. For those who need buying advice, an answer to a ques-
tion or simply want to know if there are other Macintosh users in your area
who you can call for help once in a while.

Even though some Macintosh user’s groups don’t offer “classes”, they are a
great place to learn. When Sylvia and I first started attending meetings of
the local user’s group, we took a lot of notes but never asked any questions
— we just didn’t know “what” to ask. If we did, we didn’t know “how” to
ask it. So before and after each meeting, we found ourselves talking to each
other but would slowly work our way over to other clusters of people so we
could hear what they were talking about. Usually, after returning home, we
would both say the same thing... “Did YOU know what they were referring
to?”

As with anything new or complex you must keep using it, reading about it
and finding some way to communicate a problem or question. I remember
during one meeting, while listening to someone explain their problem, I
found myself blurting out the answer. “Hey! I actually knew the answer!”
Never be afraid to ask questions. Macintosh users love their Macs and are
usually willing and friendly, when they know someone needs some help.

To find a Macintosh user’s group in your area, go to this Apple web page:
http://www.apple.com/usergroups

Sylvia and I belong to MA.C.S. (Macintosh Asheville Computer Society).

Here is their web address, where I have contributed a lot of information:
http://homepage.mac.com/macsnc



1b- Keyboard Caution

Do:

Pay attention and make the correct selection when a “Save” alert appears.

Don't:
Whenever a “Save” alert appears, don’t press any keys, unless you know which keys
activate which feature.

Explanation:

Apple has incorporated a lot of “keyboard shortcuts” into their Operating Systems
but not all of them are easily discovered. The various pop-out menus, you’ll find,
offer a sort of “cheat sheet” of keyboard shortcuts for any choice which has one.
However, some shortcuts are not to be found in any menu.

Sometimes, Apple adds a feature for your convenience but because it doesn’t have
an associated menu, Apple only gives this function a keyboard command. Because
there is no menu associated with such a function, pressing its activation keys
doesn’t make it a keyboard “shortcut”, just a keyboard “command”. (It’s also ex-
tremely difficult to find some of these.) Here are two examples:

EXAMPLE 1
« Switching to a currently-open application with the Application Switcher
1- Hold down the Command (Apple) key.
2 - Keep the Command key down and then touch the Tab key. One or more icons
will appear in the center of the screen. Each represents a program which is
currently open (in use).
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AppleWorks 6

3 - Continue to hold down the Command key. Each time you press the Tab key
the next icon in this lineup will become highlighted.

4 - When you release the Command key, the icon which is highlighted will be the
program you are taken to (switched to).

EXAMPLE 2
« Working with a “Save” alert
If you enter some text or make a change to an existing document in Mail, TextEdit,
etc. and then Close its window or Quit the program, a “Save” alert will appear. It
knows this is a new, unsaved document or that something has changed. You are
presented with these options: “Don’t Save”, “Cancel”, “Save”

- Save changes to the document “Macintosh
_Q_j Efficiency.cwk” before closing?

( Don'tSave ) ( Cancel ) € Save )

It’s obvious that you need to use the mouse to click on one of these buttons, in or-
der to make your choice. However, there is also a way to use the keyboard to make
these same choices. I mention this, not so you should begin using the keyboard for
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this type of interaction but because you could accidentally press a key on the key-
board and lose those changes. Here are the keys associated with the above buttons:

BUTTON: KEY TO PRESS:
Don’t Save Spacebar
Cancel Escape

Save Return

=Escape T —
rfl_.llll.ll A

Courtesy of Apple

Spacebar Return

In fact, these keys will work in most of the other dialog boxes you may encounter. If
a company’s program follows Apple’s programming guidelines, then these keys will
still work. Even if they don’t, be very careful when you’re about to save a document
containing important information. While you're learning about the world of Ma-
cintosh or if you are tired or stressed, it’s always a good idea to check and double-
check yourself — especially when a “do you want to save this” box appears.

Comments:

The best way to learn something is to practice. If you're not absolutely sure of
which keys activate which function, don’t press any of them — use the proven
method (use what you “know”).

As a habit, if you're presented with a message which you don’t understand or which
relates to important information you have created or gathered (from the Internet),
stop, lift your hands from the keyboard and mouse and think about this situation.



Keyboard Caution - 1b

If you simply stare at the screen and try to make sense of this “computer message”,
you may press a key or click the mouse when you didn’t mean to.

You may also want to keep your pets from being able to jump on or walk across
your keyboard. If you walk away from the computer and a cat jumps up onto the
keyboard, you may not only find random characters in your document but, because
a document can be closed and NOT saved, from the keyboard, you may return with
all your hard work gone.



1c- Typing versus “"Hunt and Peck”

Do:

Be sure to keep your fingers on the “Home Row” of keys when typing.

Don't:

Although you may only know how to type using one or two fingers while staring at
the keyboard there is a MUCH more efficient way. Learning how to type properly
isn’t difficult to do and the reward will be a 10-fold increase in the accuracy and
number of words you type.

Explanation:

When I was in high school, they made the boys take one semester of typing. (This
was WAY before the required “keyboarding” taught today.) Years later, when Syl-
via and I bought our first computer (the Apple ][+), I had forgotten how to type.

I started teaching myself programming and since this requires a LOT of typing, I
knew I had to re-learn those techniques. Then I remembered the “Home Position”.
This is the starting point or base position where your fingers rest on a keyboard

(typewriter or computer). Here are the keys involved:

KEY: FINGER:

a Left Hand, little finger
S Left Hand, ring finger
d Left Hand, middle finger
f Left Hand, index finger

Spacebar Left Hand, thumb
j Right Hand, index finger
k Right Hand, middle finger

1 Right Hand, ring finger
; Right Hand, little finger
Spacebar Right Hand, thumb



Typing versus “"Hunt and Peck” - 1c
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Co[:rtesy of Apple
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Some keyboards have a small bump in the center of the “d” and “k” keys. Other
keyboards place this bump on the “f” and “j” keys. Since this is called “touch typ-
ing”, these bumps give you feedback indicating where your fingers should be, with-
out even looking at the keyboard.

As long as you rest your fingers on the “Home Row” of keys, you're halfway to be-
coming a more efficient typist. Basically, all you have to do is press the Home Row
keys with the Home Row fingers. Any key which is not in the Home Row should be
pressed by the finger which is closest to it. The main thing to remember is to keep
your fingers over the Home Row. Although some typing teachers may frown if you
look at your fingers while typing, that’s exactly what I did when I was re-learning.
It took a while but I forced myself to keep those fingers on the Home Row. Every
time I had to type anything, I had to not only look at my fingers but also figure out
which fingers should be used for which keys. This was the hardest part because, at
the beginning, I could type faster using the two-finger method but I stuck with it
and over time I noticed my speed and accuracy were improving. Now I type around
60-words per minute!
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Left Hand Keys Right Hand Keys

Although you should look into getting proper keyboarding instructions, simply type
with the finger which is closest to it which will comfortably reach.

As a side note here... I have noticed another problem with the “hunt and peck”
method of typing. Because you're looking down at the keyboard, if an alert mes-
sage appears on the screen or you didn’t click in the correct place, you won’t know
you're wasting your time until you look up and wonder... “Now how did THAT get
there?”

Comments:

There’s a saying about having “the best tools for the job”. Since interacting with a
computer requires a fair amount of typing, it would be a very wise investment to
learn how YOU can become the best tool for this task.

Doing this one technique will make you more efficient than all the other ideas in
this book combined!



Text Efficiency
2a Clicking To Select Text
2b Dragging And Typing
2¢ Dragging versus Deleting
2d Using The Arrow Keys
2e Highlighting Lots Of Text



2a- Clicking To Select Text

Do:
Whenever you need to highlight a single word, double-click to select it.

Don't:

Carefully positioning the Pointer and then dragging across a word, in order to high-
light it, is a waste of your time and can sometimes cause you to highlight more or
fewer characters than you need.

Explanation:

Built into almost every program is the ability for you to highlight text by double-
clicking those characters. In some programs, more clicks in a row, will select more
groupings of characters. Here’s the typical breakdown:

Number of Clicks: Result:

1 Drops the “Blinking Insertion Point” and
allows you to enter text (by Typing or Past-
ing) from that point to the right. (If there’s
no more room to the right, the characters
will flow down one line. This continues
until there is no more text to Paste or you

stop typing.)
2 A single word is highlighted.
3 A single line is highlighted. (In some pro-

grams, such as TextEdit, this will highlight
an entire paragraph — even if that para-
graph 100 pages long.)

4 An entire paragraph will be highlighted.
(Even if that paragraph is 100 pages long.)

NOTE: To the Macintosh, a “word” is a series of one or more characters
which is surrounded on both ends by a space. (It doesn’t have to
be a real word.) To the Macintosh, a word which appears at the



Clicking To Select Text - 2a

top-left corner of a document is still considered a “word” — even
though it doesn’t have a space to its left. Technically, a “word” can
be hundreds of pages long. A “line” is a series of one or more char-
acters which lie in a single line between the left and right edges of

a page or between a column’s margins. A “paragraph” is a series of
one or more characters which is preceded and followed by a Car-
riage Return marker. (This is an invisible marker which is placed in
a document, at the Insertion Point location, whenever the “Return”
key on the keyboard is pressed.) To the Macintosh, a paragraph
which starts at the top-left corner of a document is still considered a
“paragraph” — even though it doesn’t have a Carriage Return mark-
er to its left. Technically, a “paragraph” can be hundreds of pages
long.

Comments:

Since this technique can be used in just about every text-entry area in the Macin-
tosh, you’ll have lots of opportunities to practice. Try to build up this habit when
changing text in a dialog box, search field (search box), when typing letters in a
word processing program, eMail, etc. Use whichever of the above methods is ap-
propriate for the situation at hand. In using these techniques, your text selection
will go faster and you’ll be more efficient.
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2b- Dragging And Typing
Do:

If you need to remove some text and replace it with some new text, simply high-
light the text and then “Paste” some Copied text or just start typing.

Don't:
If you're highlighting text, pressing the “Delete” key and then typing in new text, in
that same spot, you're wasting your time.

Explanation:

There are a few basic “understandings” or built-in helpful functions in the Macin-
tosh. One of them is this... “Whenever any text is highlighted, if you then “Paste”
text or press any key on the keyboard, the old text will be replaced by the next text.
This means, in one step (typing while text is highlighted) will result in that high-
lighted text being deleted (erased) and whatever is typed, will appear in its place. If
you had previously “Copied” some text (one character or 100-pages worth), THAT
text will appear where the highlighted text is — once you choose “Paste” from the
“Edit” menu.

2»

NOTE: This will not work in some situations. Viewing text on a web page
and “reading” (as opposed to “composing”) an eMail message, will
not allow you to delete or change that text.

@06 Untitied
Styles |w) fBE = = 3@ [ Spacing Iw) [Usts Iw) »be <o
e e

| Spring is a great time 10 enjoy the colors of the flowers, their aroma and beauty

against the backdrop of a painted sky can be worth the extra time spend on your
[ journey

£
Let‘s say this is a sentence we want to edit.
We want this to start with “the colors”.
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NOTE: Whenever the Pointer is over text which can be highlighted or ed-
ited, it changes from an Arrow \ to an I-beam I This is not only
feedback (that you can manipulate this text) but the I-beam is a
more helpful tool, when working with text.

®06 | United 4
" sapbes Bﬁ!-'.h_,ma'um . e e
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=BT T apanst he backdvop of a
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2 - Then drag to this area.
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1 - Start by placing the

(You can go "up” and Pointer between the "t”
“left” much further. Just and "h". Then hold down
be sure to stay above the mouse button and
this line of text and left drag to the left.

of "Spring”.)

®ene '  Untitled - .
Stdes WIfEEIE B W sowny W) uss W) rede
R B N e e Ay S B
'3 i o ' s 1 ’ F

5 <
oodors of e e MOMa and Deduty 30aNst Me Dackdre of a painted
DO WO e IR 3O SPENT ON YO JouImey.

:

3 - Now press the (capital) "T". This replaces all
the highlighted text with this letter and this
is the result, Once we do this, notice the
Insertion Point (the blinking. vertical line) is
now between the "T" and the "h".



Comments:

Take some time and learn what the Macintosh can do to help you with various
tasks. Taking a little extra time at the beginning and learning how to be efficient
can save you a LOT of time and frustration in the long term.
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Searching With Spotlight

When using Spotlight to search for something, you’ll have more success if
you enter part of the filename. Remember, a computer thinks “literally”. If
you'’re looking for a file called:

Project 1 - Book photos
Spotlight may not find it if you search for:

Project 1-Book photos

(This is the same as above but without the spaces surrounding the hypen)

If you enter too much information into Spotlight’s search field (text entry
box) and Spotlight doesn’t find what you’re looking for, you may assume
that item doesn’t exist.

Instead, you might want to make a habit of starting with shorter entries

or at least start with a word which would be fairly unique, in the filenames

which are stored on your hard drive. In this example, I might start with:
project

I might not include the “1” because I might not remember if I had originally

entered a space before and/or after it.

Also... Don’t be afraid to enter the middle of a word or parts of adjacent
words. Using the above example, I might try:
ok pho
or even:
1-b
The main point here... Don’t limit yourself to whole words when searching.
If you think like the Maicntosh you will have better results.



2c- Dragging versus Deleting

Do:

Drag across any text you want to replace. Then, either press the “Delete” key (to
erase that text) or type the text which is to replace it. The first keystroke will erase
and replace the text.

Don't:
Clicking next to various words and then pressing the “Delete” key on the keyboard,
until all that text is gone, is very time-consuming.

Explanation:

Many times, I have seen people click in a text box (an area where letters, words
and/or numbers have been entered) and then continually press the “Delete” key
until all of those characters are deleted. Next, they begin typing the information
they now want to appear inside that area. This is a very big waste of your time!

Let’s set up an example...

1- Open a word processor, such as TextEdit, AppleWorks, NisusWriter, etc.

2 - Enter some words which will form a 2- or 3-line (short) paragraph. (These
“words” can simply be random characters with a space added every so often.)

3 - Press the “Return” key on the keyboard twice. (We’re going to leave one blank
space and then create a second paragraph.)

4 - Enter more words and create another short paragraph.

5- Press the “Return” key two more times.

6 - Create another short paragraph.

Now, let’s observe how text-selection works...

1- Move the Pointer so it’s near the middle of the second paragraph. The Pointer
has now changed from an Arrow to an I-Beam. This is feedback from the
Macintosh telling you that it recognizes the fact that you are now over a text
area and if you Click or Drag, you will be manipulating “text” (as opposed to
graphic items).

2 - Hold down the mouse button and drag straight up so the Pointer is on the
line of text which is just above this one.
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Stop dragging here

Thi:lparagraph is only here\ /an example. This paragraph
is only here as an example. This paragraph is only here as

an example. This paragraph is only here as an example.

Start dragging here

3 - Notice that all the text from the character you started from and all the way to
the LEFT, is now highlighted. Also notice that all the text from your current
position to the right is also highlighted.

OBSERVATION
Equate dragging UP with highlighting all the text to the LEFT.

4 - Release the mouse button.
5- Click once and this will “deselect” this highlighted text.

A similar observation...
6 - Using the same paragraphs, place the Pointer near the middle of the second
paragraph.
7 - Hold down the mouse button and drag down so the Pointer is over the text in
the line just under this one.

Start dragging here

This paragraph is only here\_/an example. This paragraph
is onl}; here as an example. This paragraph is only here as
an example. This paragraph is only here as an example.

Stop dragging here



8 - Notice that all the text from your starting point and all the way to the RIGHT
is now highlighted. You'll also see that all the text from your current position
all the way to the left is also highlighted.

OBSERVATION
Equate dragging DOWN with highlighting all the text to the RIGHT.

These two observations are very important in your exploration of the Macintosh.

Now, let’s use a more everyday example...
1- Open Safari, Apple’s web browser.

If your page appears with some type of information:
2a - Look at the URL field. (This is the white, rectangle located at the top of Sa-
fari’s window where you enter the address of a web page you want to visit.)

There is a tiny icon located just to the left of the text in this box. This icon is
called a “favicon”.

a0 Insight Data - Our Services =2
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I ‘ Favicon

Click it once and all the text in the URL field will highlight. (Even the text you

cannot see. Sometimes a web page address can be extremely long and go off
the edge of this box.)

If your page appears blank:
2b - Notice that the “Insertion Point” (that blinking, vertical line) is already inside
the URL field. (This is the white, rectangle located at the top of Safari’s win-
dow where you enter the address of a web page you want to visit.)
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Insertion Point

Because of this, you don’t have to click or do anything except enter a web ad-
dress. For this example, type the word:

apple

then press the “Return” key. (With Safari, you don’t have to enter “http://” or
“www” or even “.com”.

806 Untitled
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Once Apple’s web page has appeared, go back to Step “2a” and then proceed with
Step 3.

3 - Now that the text is highlighted, you don’t have to press the “Delete” key to
remove it. Simply begin typing the text which you want to appear in its place.
For this example, type the word:

macsurfer

then press the “Return” key. (MacSurfer is a Macintosh-oriented, news and
announcements site — very handy for keeping up with the latest happenings.)

Notice that as soon as you typed the letter “m”, ALL of the highlighted text
was deleted. So, the thing to remember from this is... Whenever any text is
highlighted, most any key press will replace all of it — whether it’s the letter
“m”, a period, the Spacebar or even the Escape key. This is true in any Macin-



tosh program — whether one character is highlighted or 1000 pages, all of it
will be replaced by whatever is typed on the keyboard.

NOTE: One exception to this rule is a web page. Although you can highlight
text on a web page, pressing any key on the keyboard will not delete
it. The same is true when “reading” (as opposed to “composing”) an
eMail message.

Of course, if you change your mind, simply click once on a blank area. Don’t click
on the highlighted text for this purpose — it has other uses and could get you into
trouble when learning the above technique.

NOTE: If you need to select several pages of text, within the same docu-
ment, use the “Click, Shift-Click” method. (This is described in
more detail in “Highlighting Lots Of Text”, on page 36.) Using the
three paragraphs we created in the beginning of “Dragging versus
Deleting”, click once anywhere within the first paragraph. Now,
hold down the Shift key and click once anywhere within the third
paragraph. All the text from the first click to the Shift-Click is now
highlighted. This technique will work, even if you have to click and
then scroll through several hundred pages, in order to Shift-Click.

Comments:
If you want to replace a single line of text, start at one end or the other and drag UP
or DOWN.

If you want to replace several paragraphs of text, start at the bottom-right or top-
left and drag UP or DOWN.

As a habit, if you start by looking for the largest “target” (white space), that’s where
you should start the Pointer. Then, when you’re dragging Up or Down, do so in a
diagonal direction and you’ll be more efficient in no time.
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40f14
Use Font Book To Trim Down Your Fonts
Apple includes their Font Book program with Mac OS X 10.4 (Tiger). It’s a

great tool to organize your fonts into categories and see what each typeface
looks like.

Take some time and go through all your fonts. Look at each one and think
about all the things you use your Macintosh for: composing eMail, printing
out letters, designing greeting cards, creating newsletters (for your family
or an organization you may belong to), etc. If you see a font which you will
probably never use, you can either turn it OFF, so you can easily re-activate
it in the future) or simply delete it.

Every font you can turn OFF or delete will shorten your Mac’s startup time
and give it a little more RAM and hard drive space for other functions.
Don’t get too crazy and remove all but one font. After all, you are using a
Macintosh and Macs are meant to be explored, empowering and fun! (Be-
sides, the Macintosh Operating System will protect itself and tell you there
are certain fonts you really shouldn’t remove.)



2d- Using The Arrow Keys
Do:

If you're typing and need to move the Insertion Point to another nearby spot, use
the Arrow keys. If you're typing and need to highlight text located near the Inser-
tion Point, hold down the Shift key and use the Arrow keys.

Don't:

If you're already typing, your hands are on the keyboard. To lift one hand, grab the
mouse, drag to a new location and then click, in order to drop the Insertion Point,
is a waste of your time.

Explanation:

If you're working with text and your hands are on the keyboard and the Blinking
Insertion Point (a thin vertical line) is between two characters, then if you need to
move the Insertion Point UP one line, simply press the Up Arrow once. If the Inser-
tion Point is at the right edge of a line of text, pressing the Right Arrow key will
eventually send it to the beginning of the next line (on the left edge of the page).

Adding the “Shift” key to the use of Arrow keys will cause neighboring characters to
become highlighted — from the point where you start holding down the Shift key.
The Left and Right Arrow keys highlight the next letter. The Up and Down Arrow
keys highlight the next line.
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With the Blinking Insertion Point between the
'n" and "s" of "against”, holding down the
Shift key and then pressing the "UP" Arrow
once, will cause this area of text to become
highlighted.

If you are working in a text box which is only one-line high, such as those in dialog
boxes, pressing the “UP Arrow” will move the Insertion Point to the “beginning” of
the text — to its far left. Pressing the “DOWN Arrow” will move the Insertion Point
to the “end” of the text — to its far right.
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Here, the Insertion Point rests between the "m" and "a" of
the Safari URL field (where web addresses are entered).
Pressing the "UP Arrow” will move the Insertion Point to
the left of "http". Pressing the "DOWN Arrow™ will move

it to the far right of that same line.

Holding down the “Shift” key before using these Arrow keys will cause the text

from the Insertion Point to the “beginning” or “end” of that line to become high-
lighted.



Comments:

Think of using the mouse to move the Pointer and objects (like icons and drawing
program images) in large increments and the Arrows keys to move the Blinking
Insertion Point in small increments.



33

This page was going to be blank but we rescued it by adding a
BonusTip
50f14
Adding Icons To The Toolbar
One way to have quick access to your programs, documents, folders and
web links is to place your most-used items in the Dock and secondary items
in the Toolbar of Finder windows.
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Toolbar

Simply drag any folder, program or document icon to the Toolbar. You may
have to pause in that area before you see the items on the left and right
spread apart. Once they do, you can release the mouse button. (You may
even have to move slightly side-to-side.) The Finder will automatically cre-
ate an Alias of that item and leave the original item in its original location.



2e- Highlighting Lots Of Text

Do:
Use the “Click, Shift-Click” method whenever you have to highlight several pages of
text.

Don't:
If you're dragging across a LOT of text and waiting for all the pages to scroll by,
you're wasting your time.

Explanation:
Most Macintosh programs will display an Insertion Point (a thin, vertical, blinking
line) whenever you click once within a text area.

NOTE: Some web pages, as well as when you're “reading” eMail (as opposed
to composing eMail) will not display an Insertion Point but this
technique will probably still work unless you click on a web link.

Knowing that the Macintosh will “remember” that you clicked within a text area is
the key to understanding this facet of the Macintosh. Keep in mind however, if you
click somewhere else, even on a button, or pull down a menu, the click you previ-
ously made will probably be “forgotten”.

So, let’s see how this can help us highlight hundreds of pages worth of text...

1- Using your favorite word processor, such as TextEdit, AppleWorks, Pages,
etc., open a document or type in at least two pages of text. Random characters
will work fine for this exercise.

2 - Scroll to the top of your document.
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3 - Click once, somewhere near the top. You should now see the Blinking Inser-

tion Point.
4 - Drag the Scroll Box all the way to the bottom of this document.
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3 - Then hold down the “Shift” key bottom,
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5- Hold down the “Shift” key and click once somewhere near the last paragraph.
(Then release the “Shift” key.) At this point, ALL of the text from your first
click to this “Shift-Click” should now be highlighted. If you press any key on
the keyboard, ALL of that highlighted text will be replaced with the key you
press.

Comments:
When working with text, using the “Click, Shift-Click” method is the most efficient
way to highlight vast amounts of text.
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Reading Colored Text

Backtracking Through Safari

Multiple Windows versus Controlled Windows
Safari’s Windows

Checking For New Content

Switching Windows

Searching Google



3a- Reading Colored Text
Do:

METHOD 1
If you're reading colored text or text which is sitting on a colored background,
highlight the text. Sometimes the colors will change just enough for you to read the
words more clearly.
or...

METHOD 2

Copy the text to Apple’s TextEdit program. Select All the text and then choose “De-
fault” from the “Styles” menu, located near the top-left corner of that window.

or...
METHOD 3

Set “Universal Access” in System Preferences to “White on Black”.

Don't:

When reading text which has been colored or has had its background colored, don’t
strain your eyes. There are ways to make this easier to read.

Explanation:
METHOD 1

Dragging across text will highlight it. Although the text-color will not change, the
background will be close to the color set in the System Preferences “Appearance”
section.
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Changing the “Highlight Color” in this dialog box will cause all the text you high-
light to have this color as its background.

Sometimes when reading an eMail message or when viewing a web page, you’ll see
text which has a color other than black. Sometimes the background (the area the
words are sitting on) will have a color other than white. In any case, if the words
you are reading are difficult to see because of their color, try this:

1- Move the Pointer so it’s close to the start (top-left) or end (bottom-right) of
the text you want to read.

2 - Hold down the mouse button and drag in the opposite, diagonal direction.
When all the text is highlighted, release the mouse button. If you are trying
to read a large (more than one page) area of text, you may want to highlight
a few paragraphs at a time. In some instances you can use the “Click, Shift-
Click” method. (See “Highlighting Lots Of Text” on page 36, for details.)

METHOD 2

Here’s another technique which may come in handy...
Sometimes the above highlighting technique is still not enough to allow you to read
certain colors of text. When this happens, try the following:

1- Highlight the text you would like to read.
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2 - Pull down the “Application” menu (located to the right of the Apple), scroll
down to “Services”, slide over and down to “TextEdit”, then choose “New
Window Containing Selection”.

" m File Edit View History Bookmarks Window Help

About Safari Untitied

Report Bugs 1o Apple. .

Preferences... ®,

v Block Pop-Up Windows NX

Private Browsing

Reset Safari.

Empey Cache. .. A {3
ChineseTextConverter »

Hide Safari T [Epertoed S

ﬂfdt omm NXH Font Book >

B Grab >

Quix Safari xQ e b Eorncen i

* Look Up in Dictionary

Mall .
Make New Sticky Note oxY
NoteBook »
Open URL
Open URL in Opera XU
Opera >
Scrpt Editor »
Search With Google XL
Send File To Bluetooth Device..,
Speech »
Spotlight ONF
Summarize
TextEdit - New Window Containing Selection .
World Book Dictionary » Open Selected File
World Book Encyclopedia >
World Book Notepad »

When you release the mouse button, the highlighted text will automatically be
copied to a new TextEdit window. — although it will look as though nothing
has happened.

3 - To view this text, click once on the TextEdit icon in the Dock.
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4 - Your text may still be unreadable at this point. If it is, pull down the “Styles”
menu and choose “Default”. Most of your text should now be black and any
web links should be blue. (Your results depend on how the text on that web
page was created.)

NOTE: The two above methods of highlighting words will only work on text
which is true text and not “graphic” text. In other words, some web
pages use words which may look like “text” but that area may be
made up of a “graphic” (painted text). Sometimes words are added
to a web page as a design, so it can take on a more characteristic
or stylish look. When this happens, you are no longer able to high-
light this kind of text. If you try to drag across this area, you will
either highlight the block of words or you will drag the text-graphic.
(If you keep dragging to the Desktop, you will have a copy of that
graphic on the hard drive. Once this is done, double-click its icon
and you will be able to view that image. It’s still not “text” — you
cannot change or search through any of these “words”.)
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METHOD 3

One other technique for changing the color of text, even “graphic” text, is to use the
“Universal Access” feature of Mac OS X. Try this:

1- Pull down the “Apple” menu and choose “System Preferences...”.

2 - In the dialog box that appears, click once on the “Universal Access” icon.

3 - Inthe next dialog box, look in the “Display” section and click once on the but-

ton located to the left of “White on Black”.
enn Universal Access
[« »|[ ShowAn | a

When using this computer, | would like assistance with:

(_ Seeing Hearing Keyboard Mouse

VoiceOver: Turn VoiceOver on or off: %F5

_On ®Off | Open VoiceOver Utility... |
Zoom: Turn zoom on or off: 88

: Zoom in: 8'\.=

oOn ©Of Zoom out: B\ - [ Options... |

Display: Switch to white-on-black: 8\ ~8

@ Black on White _ Use grayscale
_ White on Black

Enhance contrast: &

Normal Maximum

Click this button Reduce contrast: 8\~ ‘
Increase contrast: 8 \.A, ()

__Enable access for assistive devices
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Every instance of “white” is now “black” and vice versa. All of the colors will change
to their opposites. (To change this back to normal, simply click once on the “Black
on White” button.)

This technique may help in those times when you encounter a web page which has
a dark background and white or light-colored text. Switching “Universal Access”
to “White on Black” will make this appear as black text on a white background

— making it much easier to read.

NOTE: In case you were wondering, if you paste the text into a new, “nor-
mal” window, the text will still be white or light-colored. You will
not be able to use the “change Universal Access to White on Black”
method.

Comments:

These techniques will work just about anywhere there is a lot of text. (It won’t work
in dialog boxes. Of course, you shouldn’t need to use this technique in most dialog
boxes because all of them should be easy to read.)



3b- Backtracking Through Safari

Do:
Use Safari’s “SnapBack” button to instantly jump back to the start of your web page
adventure.

Don't:
If you find yourself using Safari’s “Back” button, in order to find the page you first
started with, you’re working too hard.

Explanation:

Whether you used a Safari Bookmark or typed in a URL (web page address), to
start browsing the Internet, once you click a link on that page (to visit a different
page), Safari will add the “SnapBack” button to the URL field.

8 SNS) Insight Data - Our Technician

URL field i i "SnapBack” button | |

NOTE: The “SnapBack” button will disappear (reset) if you use a Bookmark
or enter another URL to jump to another web page. However, if you
then click on a web link, to visit another page, the SnapBack button
will once again be displayed. This time, clicking it will take you back
to the page which was displayed when you used that Bookmark.

Also... If you need to go back to a page you previously visited, but don’t need to go
all the way back to the last time you entered a web address in the URL field, use
Safari’s “History” menu.
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Clear History

This menu contains a chronological history of all the web pages you visited (from
the last time it was cleared). Recently visited pages are listed at the top and the old-

est ones are at the bottom.

Another method of retracing your Internet steps is to use the history menus located
within Safari’s “Forward” and “Back” buttons.
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 If this "Forward” button was active, its menu
could also be displayed in the same way,

» Apple Mac
% Insight Data - Qur Services
A Apple

To reveal this history menu, place the Pointer over this
"Back” button then hold down the mouse button.

These two menus also display chronological history information but here it is sepa-
rated by your “Back” history (those pages you previously visited during this ses-
sion) and your “Forward” history (after revisiting any previous page, the “Forward”
history menu shows the pages you came “from”.

Comments:

This is yet another great way Safari can help us be more efficient. A lot of times,
Apple places visual hints all around us. We simply have to notice them and see
where they may lead.
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Look At The Big Picture When Problem Solving
Whenever you're trying to troubleshoot a Macintosh problem, it’s a good
idea to take a step back and look at the “bigger picture”. If you get stuck in
the details of the immediate situation, you may end up trying to fix some-
thing which isn’t causing the problem. For example, if your Macintosh
won'’t start, you may think the software is at fault — and it could be. How-
ever, sometimes even a USB hub can suddenly become faulty and keep your
Mac from starting or going to sleep.

With over two decades of troubleshooting Macs, I've come to the conclu-
sion that problems reside in just a handful of areas. Trace the problem

to one of those areas then fix that area and you will solve the problem.
Because “software” and “hardware” problems can sometimes seem like
they’re actually the opposite problem, the most difficult part of “repairing”
a Macintosh is isolating the problem. If you ask enough questions, trying to
move the problem from one area to another, you’ll find that you will begin
to elliminate one or two areas and find yourself focusing on one in particu-
lar. Here are some basic areas to keep in mind when troubleshoooting:

« Disconnect everything from your Macintosh except the keyboard, mouse
and monitor.

 If you hear what sounds like a ping-pong ball bouncing on a wooden table,
the hard drive is breaking down. Back up everything you can as soon as
possible.

« On Startup: If the screen is stuck on blue or gray, the problem is probably
in the Operating System, hard drive or logicboard; If the screen is stuck
on black, the power supply “may” have gone bad; If you hear beeps (I'm
not talking about the Startup Chime), it means one or more RAM modules
have gone bad.

« If there’s something wrong with the Operating System, start fixing it by
replacing like-for-like with the “Combo” update. (Fox example, if your
Mac has 10.4.7 installed, download the 10.4.7 Combo Update.)



3c- Multiple Windows versus Controlled Windows

Do:

Whenever you want to keep the current web page open, but need to view a differ-
ent page, use one of Safari’s Modifier Keys — such as Command or Command and
Option.

Don't:
If you find yourself clicking on a web page link and then relocating and reopening
the page which was previously displayed, you're working too hard.

Explanation:

Alot of times, when people are looking for something on the Internet, they have a
specific goal in mind. However, there are times when you are following a certain
idea or topic and come across similar, but unrelated, information. If you simply
click on that unrelated link, the contents of the current web page will be replaced
by that new information. This scenario is not too difficult to find your way back
from. Once you've finished with that new page, you would just click the “Back” but-
ton and your original (previous) page will appear.

Sometimes unrelated information can take us down a very long road — with each
unrelated link spawning new ideas and more unrelated links. It can be baffling just
to remember your original purpose, not to mention the difficulty in trying to locate
that first gem of a web page which you discovered early on.

By opening new links in either a “Tab” or its own window, you can always find any
part of your trail quickly and easily.

For some reason, Apple sets Safari’s default “Tab” feature to “Disabled”. So before
you can use the above information, you must activate this feature. Here’s how to do
it:
1- While in Safari, pull down the “Safari” menu and choose “Preferences...”.
2 - Click the “Tabs” button, which is located in the Button Bar of this dialog box.
3 - Ifthere is no checkmark in the small square located next to “Enable Tabbed
Browsing”, then click this box once. (A checkmark will appear.)
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4 - Close this dialog box. (Just click once on the red “Close” button, located in the
upper-left corner of this dialog box.)
5- Now you can tryout Safari’s “Tab” feature.

Before trying out this feature, there’s one more Safari setting you need to have acti-
vated. Pull down the “View” menu and choose “Show Status Bar”. (If you see “Hide
Status Bar”, then this has already been done.)

Insight Data - Our Services
69 htep: //homepage.mac.com/macosmos/ o

This Tab is Clicking this Tab will
showing the display an unseen page
current page
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Once you do this, you’ll be able to see the web address represented by most any
button or link the Pointer is over. In other words, just before clicking on a button
or link, leave the Pointer ON that item, without clicking. Then look at the very bot-
tom-edge of that Safari window.

r

@ Safari Fde Eon m History Bookmarks Window Help

Hide Address Bar x|
Customuze Address Bar,

Show Bookmarks Bar OX8

| Show Sutus Bar — %/ |

Text Encoding »

You should see a “URL” (web address) like the one in the example above.

Below, I'll explain how to use the “Command” and then the “Command Option”
keys, to create Tabs and new windows in Safari. Right now, you should take a
minute to notice the information which appears in the “Status Bar” whenever these
keys are pressed.

il

- | RS

- Go to "http://homepage.mac.com/macosmos/technician.html” — /]

Whenever the Pointer is over a button or link AND the “Command” key is pressed,
you should see something similar to this, in the Status Bar at the bottom of that
Safari window. The key words here are “in a new tab”.
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Open “http://homepage.mac.com/macosmos/technician.html!” in a new tab behind the current one 4

Whenever the Pointer is over a button or link AND the “Command” and “Option”
keys are both pressed, you should see something similar to this. The key words
here are “in a new window”.

Now, let’s continue with learning about Safari “Tabs”...

Command key- (Show new link as a “Tab” in the current window) Hold down the
Command key and then click once on a web page link or button. Do this whenever
you want to keep the current window open and still have a new window open in a
new “Tab”.

————————— =) <>

| Open “http://homepage.mac.com/macosmos/technician.html” in a new window behind the current window 2

By doing this, a second window will not open. Instead, the link you click on will
open in a new “Tab”. This is a window which is not seen unless its “Tab” is clicked.
Safari allows you to open any number of tabbed windows.

Command Option keys - (Show new link in a new window) Hold down both the
Command and Option keys and then click once on a web page link or button. Do
this whenever you want to keep the current web page window open and have a
completely separate window for a new link.

NOTE: A new Safari window can open on either the left or right side of the
current window. To learn how to make optimum use of this situa-
tion, see “Safari’s Windows” below.

Comments:
Using Safari’s “Tabbed” window options, you’ll be able to explore lots of unrelated
web pages and still be able to quickly get back to any of your original page.



3d- Safari's Windows

Do:
Once you open Safari, move its window to the right so its right side is slightly off
the right-edge of the screen.

Don't:
Placing your Safari windows “just anywhere” or not moving them at all, can add
more confusion and work for you.

Explanation:

I rarely open my Safari windows as wide as they can go. (I use a 17-inch iMac G5.)
For one thing, I keep the “Dock” on the left side of my screen. (See “Dock Place-
ment” on page 66, for more information.) Instead, I keep my window a little wider
than the nine entries in my Safari “Bookmarks Bar”. This is about the width of an
average web page.

When Safari first opens, I drag the “Titlebar” of its window toward the right edge
of the screen. I make sure that the right side of this window is slightly past the
screen’s edge — about a sixteenth of an inch or so.
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O sernies Our Services

* One-on-one training customized to your needs, ot your location.

o Information and step-Dy-step INstructions are notated by an assistant during the training - at no
extra charge. This means, you can concentrate on what you are being taught -- knowing that notes

- y are constantly Seing taken during the lesscn. AL the end of the session, thise notes are frinted (on

DiskWarrior 3 owr pricker) and left with you for future reference.
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Recommended
Products
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Most of the time the response you receive is either far too brief, too technical to understand or they only
5 Vantages : angwered one of your IMPoant Questions. We donT work that way.
’

Our eMad responses are:
* Researched and venfied,
‘----] * Thoroughly soefied cut with complete step-Dy-step instructions, and
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MAKING IT BETTER
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o Oock-Battery installation + most models.

. ﬂi" instatation, updeting and sety

This arrangement does two things for me:

[.(

1- If I'm reading the contents of a web page and need to scroll down, I don’t
even have to look at the Pointer or the Scroll Bar of the window. I simply
move the mouse all the way to the right. Because the Pointer will not move
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off the edge of the screen, as long as I have positioned the Pointer under the

Scroll Box (the vertical, blue area, located in the Scroll Bar), I can click the

mouse once and the web page will instantly jump up — what was the last line

on the bottom of this window is now at the top of this window. (I haven’t lost

my place. I simply move my eyes to the top of this window and continue read-

ing and I never had to look at the Pointer.)

e  iasight Data - Our Sarvices
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2 - If I need to open a web page in a new window of its own Safari will open that
window on the right or left side of the current window. (See “Multiple Win-
dows versus Controlled Windows” on page 50, for more information.) How-
ever, if the active Safari window is positioned all the way to the right, any new
windows open to the left.

If you open more than one window, without clicking on them (to bring them in
front of the current window), you’ll notice that the first window opens as far left
as it can. The next window opens in front of that one but slightly (about a quarter-
inch) right of that one and so forth.

Comments:

Position your Dock on the left side or at the bottom of the screen. Then you’ll be
able to make the most efficient use of Safari by placing your main window at the
right edge of the Macintosh screen.



3e- Checking For New Content

Do:

After reading a web page for a while, if you want to know if new information has
been added, click the Refresh button and immediately place the Pointer over one of
that page’s distinguishable items — a button, an article title, etc.

Don't:
Clicking the Refresh button and then scouring that web page, in order to see if any
new content has been added, can take a lot of time.

Explanation:
Whenever you click the “Refresh” button in Safari, once that web page is reloaded,
Safari will scroll that window to the same position you were previously reading.

With this in mind, we can use this information to help us determine if any new
content was added “above” our current window position or if any information was
removed. This will not tell us anything about information which is “below” our cur-
rent window position.

So, let’s say you've been reading a web page for several minutes and it’s a news
page which is updated every few minutes or so. Right now, you’re halfway down
that web page and you decide to see if any new content has been added “above” this
halfway point.

Before clicking the Refresh button, look for some sort of reference point within the
part of the window you are viewing. This could be a title, a graphic embellishment,
etc. if that page has menus or advertisements down one or both sides, do not use
these areas for feedback because they probably won’t change and this is not the in-
formation you're looking for. Instead, you want to look for the content itself — the
text you have been reading. (Something near the top of the area you are currently
viewing would make it easier for you to move the Pointer near, before the page
starts refreshing.)
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Don’t do this yet, but you’re going to move the Pointer so it’s on top of or next to
whatever feedback marker you decide to use. When you do this, don’t click on any-
thing. Just place the Pointer near something you can use as feedback.

Now, click once on the Refresh button and then immediately move the Pointer near
the feedback marker.

meurswum AM mmmmmmmmw ‘I'M
result of this alowed everyors 1o contnibate thalr own ideas and designs for & Andhed

2 - Now click "Weicome to MA.C.5." program ~ which was dstributed to all members. {1996)
once on
Safari's ¢ Departmest of Continuing Education, University of North Florida.
“Reload”
button. o Two-cay PageMaker morkibep. (1989)

® Clasiroom and indwvidoal Mackstodh iInstruction, consulting, troubleshooting.
9 A vanety of Maantesh programs - from basics to page lyout. (1984 1o present)
* Microage Computer Store, AlbuGuUErgue, New Meoce.

o Semina/Oumnds of Npha Syrtacr! Computier/Music System. (1982)

1 - Place the Pointer near a title or button
PROGRAMMING & _ (something you can remember).

o Beta temted Ready Set Gol' versions 6 & 7 (Madntosh page yout software) for Manhattan Craphics
Corp. (1993 & 1994)

* Beta tested 'Appielink Personal Edtion’ (onkne service now known as ‘Amerncs Onine’) for Quantum
Computer Services, (1988)

* Beta temted Amernica Deline version 3. (1997)

o Beta temed ‘Scoop’ (Maontosh page lyout software) for Target Software. (1987)

® Author of two, nationally sold, “Pow 20" disks for Apple ) users. (1986.1987) (see “Computer
Encounters” In the "Authoring” section below)

* Appie Cortified Developer of Macimtosh software, (1586-1990)

* Squesk: MyperCard-based program which teaches Macintosh users how to use the mouse. (no longer
avalabie )

® ShutdowaNotes: HyperCard ased prograrm witich dsplays 2 user-defined reminder whenever the
Naantosh 5 shat dowmn. (Ao lonper avadable)

* Deta tested ‘MuitiScribe’ (word processing software for the Appie 11 computer) for StyleWare, inc
(198¢)

o One of four Agpie /// programmers o Sunspot, Inc. who helped write a comprehensive management
program for radho stations. Also 0d telephone and on-site tech support. (1982-1984)
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* Seif-pubinted & computer rescurce guide, It contained contact and product Information on Just aboyt
every computer-reiated busness in ABuguengue, NM, (158))
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Encounter” seres, these books explained the features of the Apple ][ computer. Two of them came i
with Noppy diaks which contained progrrms wrtten by me. This software, slong with the e
DECOMPanying Book, taught beginrers how to program. (1986-1987) “
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Once this page has reloaded, if the feedback marker (“PROGRAMMING”, in this
case) is “lower” than it was (below the Pointer) then that much content has been
added since you first visited this web page during this session. If the feedback
marker is “above” the Pointer, then that much information was removed since you
started reading this page.

Knowing how much information was added can help if you decide to scroll back
up this window to see what’s new. Of course, if the feedback marker stays near the
Pointer, no new information has been added or removed and you won’t waste your
time going back looking for new information.

A variation to this technique will help if you're too slow, or your Internet connec-
tion is too fast, to move the Pointer into position before the page refreshes. If this
is your situation, simply open this same page in a new window. At that point, the
page will be “refreshed” (updated) and you can compare the two side-by-side. This
technique is also better if you want to know exactly what has been changed, from
the time you first opened this page.

NOTE: The following steps will only work if the “Tabs” section of Safari’s
“Preferences” has been set to “Enable Tabbed Browsing”. (This is
explained in “Multiple Windows versus Controlled Windows”.)

So, here’s how to do it:

1- Click once in the URL field (Web address box at the top of the window).
aNnn Insight Data - Our Technician

| Sy Aa/Af G SRD:/fhomepage.mac.com/macosmosjtechiidanitnl L
[0 MacCentral MacSurfer MacOSrumors VersionTr N\ Mac Apple Hot News MadedMac Polyloopnet CafePressv
U mypercara programmingiii G (SpeCEn INTErest Group) oF MULLS. (Mo oS!y Asnevine
Computer Society). A shqil, beginner’s class on how to program in HyperCard. The
result of this ? ne to contribute their own ideas and designs for a finished

Click once, [ —e—peiram -~ which was distributed to all members. (1996)
anywhere

Wlthlﬂ the ¢ Department of Continuing Education, University of North Florida.

URL field

2 - Hold down the Option and Command keys and then press the Return key.
(Now release all 3 keys.) This page will now open behind the current window
(refreshed) in a new window. The page you had been viewing will remain on
the screen. Now you have an old version and an updated version.
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Titlebar

o Departmest of Continuing Education, Unhversty of North Florida.

o TwoSay PageMaiker morkahop. (1969)
® Clasiroom and indvidual Mackstodh Instruction, consuling, troubleshooting.

9 A vanety of Maantosh programs «~ from basics o page layout, (1984 1o present)
* Microage Computer Store, Abuquergue, New Meocs.

o Semina/Oemos of Npha Syrtacr! Computer/Music System. (1982)

PROGRAMMING

o Beta tested Ready Set Gol' versions 6 & 7 (Macintosh page lyout software) for Manhattan Graphics
Corp. (1993 & 1994)

* Beta tested Appielink Personal Edtion’ (onkne service now known as ‘Amernca Onine’) for Quantum
Computer Services. (1588)

* Beta tested America Online version 3. (1997)

* Beta tested ‘Scoog’ (Maontosh page layout software) for Target Soft 1987)

® Author of two, nationally sold, “Powt0” disks for Apple )| users. (1986.1987) (see “Computer
Encounters” in the "Authorieg” section below)

* Appie Cortified Developer of Macitosh software, (1586-1990)

* Squesk: MyperCard-based program which teaches Macintosh users how to use the mouse. (no longer
ovalabie)

o ShutdownNotes: HyperCard based prograrm whtich dspidys a user-defined reminder whenever the
MNaGntosh i Shet down. (Ao longer avadable)

* Dato tested MuitS " (word pr 9 soft for the Appie 11 computer) for StyleWare, inc,
(198¢)

o One of four Agple [/ programmers o Sunspot, Inc. who belped write 2 comprehensive management
program for radio stanions. Also 0d telephone and on-ske tech support. (1982-1984)

The Resize Box

AUTHORING

* Seif-pubinted & cOmputer rescurce guide, It contained contact and
every computer-reiated busness in ABuguergue, NM, (158))

® Self pubished four computer IPStruction books distributed nationaly. Known
Encounter” series, these books explained the features of the Apple ][ computer. T
with Nopoy ks which contaimed programs wrtten by me. This software, slong with th
DCOMPAn ying Book, taught beginmers how to program. (1986-1987)
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Drag their Titlebars and Resize boxes to position and size them, so you can see all
or most of them side-by-side.

Comments:

If you find yourself reading long web pages and need to know “if” and “how much”
new information has been added, during that session, use this as a habit and you’ll
have instant feedback.



3f- Switching Windows

Do:

Click once in the gray area of the window’s “Titlebar”.

Don't:

Clicking on a window, which is behind another window, will bring it to the front
and make it the active window. However, clicking “just anywhere” can activate a
web link which you did not intend to use.

Explanation:

When you simply click on a web page, which is behind the one you’re currently
viewing, you could be clicking on a button or other hyperlink (active text which, for
example, could take you to another web page). When this happens, you waste time
and can lose your place.
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Comments:
As a habit, it’s safer and more efficient to click once on the gray part of a window’s

“Titlebar”.
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3g- Searching Google
Do:

Use Safari’s Google search box whenever you want to use Google to find informa-
tion on the Internet.

Don't:
Visiting the Google web page and then entering search criteria is a real waste of
time.

Explanation:
I hesitate to include such an obvious tip in this book but because I have seen a few
people not know this feature is available, I thought it should be mentioned.

806 Untitled

EES B3 G H{Q- Googre N

— — |

Click once in this text field, enter your search
criteria, then press the Return key and you'll
instantly have Google searching the Internet.

Apple has provided a way to directly use Google to search the Internet right within
the Safari window. In the upper-right corner of each Safari window is a “search
field” (a box which allows you to type in information). Enter the keywords, subject,
etc. which you would like Google to search for and then press the Return key.

Comments:

This is yet another example of a helpful feature being in plain view. You will make
better use of what the Macintosh has to offer by taking things slowly, at least at
first, and noticing the various buttons, design embellishments and places to type in
text, etc.



Dock Efficiency

4a Dock Placement
4b Hiding versus Not Hiding The Dock

b 43

4c¢ Locating A Dock Item’s “Original”
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4a- Dock Placement

Do:
Pull down the Apple menu and select “Dock”, then move to the right and in the
sub-menu, choose “Position on Left”.

"ICJ Finder Fie Ednt View Co Window Help
About This Mac

Software Update..
Mac 05 X Software. ..
System Preferences.,
BTN Turn Hiding On XD
Location » Turn Magnfication Off

Force Quit... XD
Posntion on Bottom

e Posiion on Right
Restan. .

Shut Down.. Dock Preferences...
Log Out Apple 5Computer.,, OXQ

Don't
Placing the Dock on the right side of the screen partially covers some Desktop
items. Placing the Dock on the bottom of the screen shortens your screen’s height.

Explanation:

Whether you have a portable or desktop Macintosh model, look at your screen.
Notice that its shape is not square but rectangular — it’s wider than it is tall. This
means you have more screen “real estate” left-to-right than you do top-to-bottom.

Because our screens are short, it makes sense to maximize their height by moving
the Dock off the bottom.



Dock Placement - 4a

When the Macintosh automatically places downloads, new folders, etc. on the
Desktop, it places them on the right side of the screen. It starts with the first avail-
able space under the hard drive icon and moves downward from there. (Once there
is no more space vertically, the next item starts at the top, just left of the hard drive
and then the next one is placed under that and so forth.) Because of this, it makes
sense not to block our view of the right side of the Desktop.

Taking all of this into consideration, the most efficient location for the Dock is on
the left side of the screen.

Comments:

Keeping the Dock on the left side of your screen will:
« Give you a slightly taller screen to work with (as in taller windows).
« Give you a clear view of the right-most area of Desktop icons.
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4b- Hiding versus Not Hiding The Dock

Do:

Leave the Dock displayed on your screen.

Don't:

Hiding the Dock can make more work for you.

"IC) Finder Fe Edt View Co Window Help
About This Mac

Software Update .

Mac 05 X Software. ..

System Preferences

Location » j Turn Magnification Off

Force Quat. .. XEY | v Posttion on Left
Position on Bottom

eep Posiion ca Right

Restan.

Shut Down.. Dock Preferences...

Log Out Apple 5Computer.., OXQ

Explanation:

In the Apple menu, under “Dock” there is a sub-menu which will allow you to
“Turn Hiding On”. This will hide the Dock. Unless you need all of the screen for a
certain program, it’s more efficient to leave the Dock showing.

If the Dock is hidden, moving the Pointer to that edge of the screen will temporar-
ily show the Dock. Make your selection, then move the Pointer away from that area
and the Dock will once again be hidden. Doing this will cause you to reacquaint
yourself with the items in your Dock. Since the Dock can store the aliases of pro-



Hiding versus Not Hiding The Dock - 4b

grams, documents, folders, web links, photos, movies, windows, etc., trying to sort
out what’s stored there, each time you un-hide it, can make more work for you.

Comments:

If you always leave the Dock visible, over time, you’ll notice that you have become
more familiar with its contents. This means you’ll be more apt to store new items

and new types of items there as well as become more efficient whenever you need
to access those items.
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4c- Locating A Dock Item's "Original”
Do:

When trying to locate where a Dock item (program, document, etc.) is stored, use
that item’s Dock menu.

Don't:

If you're reading a document or working in a program and would like to know
where that item is located (folder, hard drive, CD, etc.), don’t start sifting through
all your folders. This can waste a lot of time.

Q Remove from Dock

Open at Login

Show In Finder |
\ Open |

Explanation:

All of the items in the Dock are “Aliases” — they’re not real. When clicked, the only
job of an Alias is to inform the Macintosh “where” that particular item is store. This
also applies to items which are not in the Dock until you open (activate) them.

Sometimes, when a program or document is open, you may want to know exactly
where it is stored. Here are the steps to have the Dock help you with this task:
1- Place the Pointer over one of the items which is in the Dock.
2 - Hold down the mouse button and a menu will pop out.
3 - Slide over and choose “Show in Finder”. When you do, that item’s “original”
will appear and be highlighted (probably in gray).

Comments:
When searching for a Dock item, the fastest, most efficient way to find it is to use
its Dock menu.
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5a
5b
5C
5d
5e
5f
58
5h
51
5
5k
5L
5m
5n

Closing versus Minimizing

Closing versus Activating

Dragging An Obstructed Window

Closing versus Locating

Switching Windows

Jumping To A Folder From Its Opened Window Of Content
Locating The Source Of An Open Document
Window Drag Speed

The Titlebar Icon: Relocating A Folder

The Titlebbar Icon: In Various Applications
Contextual Menus

Selecting Items In List View

Selecting Items In Column View

Selecting Items In Icon View
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5a- Closing versus Minimizing

Do:

Click once on the yellow “Minimize” button, which is located at the top-left of every
window. This will make that window small (thumbnail size) and place it in the
Dock for easy access.

Untitied
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The green "Resize” button
The yellow "Minimize” button

The red "Close”™ button

Don't:
Clicking the red, “Close” button, which is located at the top-left of every window, is
a waste of time because you may turn right around and open one or more of those

windows.

Explanation:

If there is a window in your way and you need to temporarily get rid of it, so you
can see the items underneath, simply click the yellow, “Minimize” button which is
located in the top-left corner of every window.



Closing versus Minimizing - 5a

Doing this will instantly shrink that window and place it into the Dock. You can
minimize any number of windows from any open program. If you would like any of
those windows to reappear on the screen, in full-size, simply look in the Dock for
the one you want and click once on its icon.

Although you could place the Pointer in the Titlebar of the window and drag it to
a different part of the screen, clicking the “Minimize” button is faster in removing
that window to and from the screen.

Comments:
Remember the yellow, Minimize button and use it whenever you want to temporar-
ily remove a window.

Doing this as a habit will sometimes keep you from doing extra work. Some pro-
grams have a limited workspace and if you drag the main window to a different
location, you may have to spend extra time lining it up precisely as it was before.



72 Window Efficiency

5b- Closing versus Activating

Do:
Whenever you have more than one window open and you want to Close one of the
non-active windows (behind the one you’re working on), click its “Close” button.

When the Pointer is
over this group of
buttons, their colors
will appear. Click
once on this button
and its window will
close.

Don't:

With more than one window open, if you click a window which is behind the one
you’re currently working in, just so you can bring it to the front and then Close it,
you’re wasting your time.

Explanation:

Since Mac OS X will help you work with a window which is not the current one, use
this to your advantage. Whenever more than one window is open, have you ever
noticed that the buttons (red, yellow, green), located in a window’s upper-left cor-
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ner become colored whenever the Pointer is hovering over them? Use this feature
whenever you want to Close a window which is tucked behind another.

Instead of clicking on that window, so it will come to the front, and then Closing it,
see if its Close button is accessible. If it is, move the Pointer over it and click once.

Comments:

This method will work in the Finder and most programs. Notice and use the fea-
tures which are built into the Mac OS X Operating System. This one, like a lot of
others, can save you some time.
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5¢c- Dragging An Obstructed Window

Do:
Whenever a window is partially hiding another, if you need to see that other win-
dow AND the current one, simply Command-Drag the obstructed window’s Title-
bar.

Don't:

If you need to view two windows and one is partially covered by the other, simply
dragging its Titlebar (without the Command key) may have you going back-and-
forth (move one, move the other) until you get them were you need them. This can
be a waste of time.

Explanation:
There is a Macintosh feature which a lot of us forget about: Command-Dragging.

Place the Pointer in
the Titlebar (but not
over the window's

name or its icon),
then hold down the
Command key and
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Here’s how to do it:

1- Position two windows so they are overlapping each other — similar to the ex-
ample above. Only one window can be the “Active” window (indicated by the
colored dots in its upper-left corner). However, the window in the back can be
moved without making it Active. (If you simply click on the back window, it
will be brought to the front and made Active.)

2 - Move the Pointer so it’s in the Titlebar of the back window.

3 - Hold down the Command key on the keyboard.

4 - Now, with the Command key still down, drag the mouse. When done correct-
ly, the back window will move but will not become Active.

NOTE: Attempting this while the Pointer is over the window’s Title, will
not work. Since the icon to the left of the window’s Title has its own
purpose, dragging this (for this technique) will also not work. (If
you drag this icon, without holding down any keys, you will relocate
where that folder is stored. See “The Titlebar Icon: Relocating A
Folder” on page 90, for more information.)

Comments:

The “modifier keys” (Command, Option, Shift and Control) not only work with
other keys on the keyboard but also allow you to activate other features when using
the mouse.
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5d- Closing versus Locating

Do:

Press the “F9” key on the keyboard, in order to locate any currently open window.

Don't:
Don’t close all the currently open windows just because you've lost your place and
all you see is a sea of windows.

Explanation:

I've seen this happen many times... A person opens several windows and at some
point they become confused as to what they are seeing and where they need to be.
They only thing they can think of is to start closing windows — maybe they’ll find
something familiar or can at least start over.

F10 Fl1

I SRR

Courtesy of Apple

F9 - (Show every window) Pressing this key will shrink EVERY currently open
window and place all of them side-by-side on the screen. Move your Pointer
over any one of them and the name of that window will appear in its center.
At that point, you can click once and that window will come to the front. (The
others will be displayed as they normally were.)

F10 - (Show program windows) Pressing this key will shrink every window which is
associated with the PROGRAM you are currently using and place all of them
side-by-side on the screen. Move your Pointer over any one of them and the
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name of that window will appear in its center. At that point, you can click
once and that window will come to the front. (The others will be displayed as
they normally were.)

F11 - (Show no windows) Pressing this key will move every window off the screen.
This will allow you to see the entire Desktop without the obstruction of a
single window.

If you change your mind after pressing one of the above keys, you can either press
that key again or simply press the “Escape” key (labeled “esc” and located in the
upper-left corner of the keyboard). Once you press either of these, all the windows
will return to their original positions.

Comments:

Closing windows or moving them to one side is not very efficient and can cause
you to forget what you were doing. So as a habit, practice using the F9, F10 and F11
keys.
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5e- Switching Windows
Do:

Click once in the gray area of the window’s “Titlebar”.

Don't:

Clicking on a window, which is behind another window, will bring it to the front
and make it the active window. However, clicking “just anywhere” can cause un-
wanted and even unnoticed results.
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Explanation:
When you simply click on a window, which is behind the one you’re currently view-
ing, different things can happen, which you may not be aware of...

«  Word Processor - If you click on the window of a word processing program
(such as TextEdit or AppleWorks), you may move the “Blinking Insertion
Point”, which may cause you to lose the place where you were previously typ-
ing.

« Drawing - If you click on the window of a drawing, Web-Design or Page-Lay-
out program (such as Adobe Illustrator, Freeway Express, Adobe InDesign,
etc.), you may accidentally move a block of text or a design.

Comments:

As a habit, it’s safer and more efficient to click once on the gray part of a window’s
“Titlebar”. (It’s more efficient because, if you accidentally move something, you
won’t have to “Undo” it or figure out where you left off.)



5f- Jumping To A Folder From Its Opened Window

Do:
Pop-out the window name menu whenever you want to know which folder that
window is stored in.

Don't:
Closing a window and then poking around in lots of other folders is very inefficient.
Let the Macintosh help you.

Explanation:
Sometimes, while in the Finder, you are looking at a window and would like to
know where this window’s folder is stored. (Remember, every window displays
the contents of a folder or a storage device (hard disk, CD, Flash Drive, etc.). If
you leave a folder on the Desktop and months later can’t remember where it came
from, here are the steps to locate its “Parent” folder (where this folder is stored):
1- While in the Finder, looking at a window, move the Pointer so it is over this
window’s name in its Titlebar.
2 - Hold down the Command (Apple) key.
3 - Keep that key down and then click the mouse button. (You can now release
the mouse button and the Command key.) The menu that appears represents
the hierarchy of where this folder is stored.

The upper-most item in this pop-out menu is the name of the folder you are cur-
rently viewing. The next item down is where THIS folder is stored. THAT folder is
stored in the item below it (in this list), and so forth.
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The item above is inside this folder
The item above is inside this folder

The item above is on this hard drive
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You can click on any item in this menu and those contents will be displayed in this
window. If you change your mind and don’t want to choose one of these menu
items, you can always move the Pointer off this menu, click once and this pop-out
menu will disappear. (Another way to accomplish this is to simply press the Escape
key.)

Comments:

As a habit, when looking for the location of a Finder window’s folder, it’s faster to
Command Click on the Titlebar of a window than it is to start opening every folder
you see.
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5g- Locating The Source Of An Open Document

Do:
If you are viewing a text or graphics document, which is stored on a hard drive, CD,
Flash Drive, etc., and you want to know which folder that document resides in, do
the following;:

1- Move the Pointer over that window’s name in its Titlebar,

2 - Hold down the Command (Apple) key,

3 - Then click the mouse button.

4 - At that point, a menu will pop-out.
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The top-most item is the document you are currently viewing. The item just below
it is where this document is stored. The item below that is where THAT folder is
stored, and so forth. If you choose any of those items, a “Finder” window will open
and that item will be highlighted.

Don't:

Searching for a document which is currently open can be very time-consuming. If
you start opening folders or even use “Spotlight” or the “Find” feature, you will be
working too hard.

Explanation:

Let’s say you're currently viewing a few different documents. Maybe you’ve been
working on a project and have several revisions — each in their own folder. You
open them all and now decide to copy one to a CD or attach to an eMail message,
but cannot figure out which document came from which folder. This technique will
help you find it quickly.

If an application has been written according to Apple’s programming guidelines,
the above tip will work. This is a very fast way to learn where an open file (currently
being read) is stored.

Comments:

As a habit, become familiar with the various components which make up the vari-
ous windows and dialog boxes. Sometimes, even the smallest detail is actually a
functional item and not just a “design element”. The Macintosh will help you in
many ways but you have to know “when” a helpful feature is at your fingertips and
“how” to access it.



5h- Window Drag Speed
Do:

Keep the bottom edge of text documents and web page windows at least a quarter-
inch above the bottom-edge of the screen.

Don't:

Whenever you reposition a window be sure its bottom-edge is not “at” or “below”
the bottom-edge of the screen. If you simply want to temporarily move this win-
dow, so you can see what’s behind it, use its yellow Minimize button.

Explanation:

Whenever you place the Pointer within a window, hold down the mouse button and
drag, you “highlight” any text and graphics which may be on that page. If you keep
dragging until you reach the bottom-edge of that window, the window itself will
scroll and you’ll be able to continue highlighting whatever is now appearing, from
below the bottom-edge.

If that window’s bottom-edge is “at” or “below” the bottom-edge of the screen, this
window will not scroll in this manner. (Of course, you can always use the Scroll
Bar, Scroll Box or Scroll Arrows (unless they're off the screen) but this is an awk-
ward way to easily highlight whatever is in that window.
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In order for this “drag-scrolling” technique to work, the bottom-edge of that win-
dow must be at least a quarter-inch above the bottom-edge of the screen. In fact,
you can control the scroll “speed” as you drag. If the bottom-edge of that window
is 1 to 5-inches from the bottom-edge of the screen, you can achieve an even faster
drag-scroll speed.
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Try This:

1- Open a document which has a lot of pages or open a long web page.

2 - Click that window’s green Resize button, in order to get that window’s 4 sides
positioned within the boundaries of your screen and out from under the
Dock.

3 - Place the Pointer so it’s over the Resize box (located in the bottom-right cor-
ner of that window) and drag up until you have 1 to 5-inches of space between
the bottom-edge of that window and the bottom-edge of the screen.

4 - Make sure this window’s Scroll Box is all the way at the top of the Scroll Bar.
(This will give you the maximum scrollable length, for this particular window,
to practice with.)
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5a - Place the Pointer within this window, preferably on some text, hold down the
mouse button and drag down past the bottom-edge of that window.

5b - Reset this practice window. (Drag its Scroll Box all the way to the top.) Now,
drag down again. This time, as the Pointer approaches the bottom-edge of
that window, slow down and try to place the very tip of the Pointer right
on the bottom-edge of that window. When done correctly, this window will
scroll very slowly. Drag down just a tiny bit further and the scroll speed will
increase slightly. Practice with various distances and you’ll be able to control
the scroll speed, the way you want, every time. Maybe use a slow scroll to read
the text as you highlight it. Maybe use a fast scroll speed whenever you just
need to highlight a large block of information.

Comments:

By making it a habit to keep the bottom-edge of your windows above the bottom-
edge of the screen, you won’t have to reposition a window whenever you want to
highlight more information than is currently visible.



5i- The Titlebar Icon: Relocating A Folder

Do:
If you're viewing the contents of a folder, while in the Finder, and you need to relo-
cate that folder to a new location, or copy it to another hard drive, CD, Flash Drive,
etc., it’s much faster and easier to drag that window’s Titlebar icon to the new loca-
tion.

Don't:

When you’re already viewing the contents of a folder which you want to relocate,
don’t close that window or use the Back button. This wastes time and you could
lose your place.

Explanation:

Apple adds a lot of features to the Macintosh Operating System. Some of them are
not obvious at first glance. The icon, located to the left of a window’s name (in its
Titlebar) is such a feature. This icon is not simply a “design element” (something
pretty to look at). It actually provides two functions. (One I'll explain here. The oth-
er will be explained in “The Titlebar Icon: In Various Applications” on page 94.)

In the steps below, we’ll create a new folder, just for this exercise. Simply follow the
steps, and when we’re done, this new, empty folder will be moved to the Trash.

Here’s how this icon works:

1- While in the Finder, pull down the “File” menu and choose “New Finder
Window”. (Yes, you could have simply double-clicked on the hard drive icon,
located at the top-right corner of the screen, but some people may have set
their Finder Preferences so this icon does not appear on the Desktop.)

3 - Navigate to your “Home” folder. (The fastest way is to click once on the
“Home” icon, located in the “Sidebar” of each Finder window.)

4 - With this window still active, pull down the “File” menu again but this time
choose “New folder”. You should now see a new “untitled folder” in this win-
dow.
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5- Double-click on the “untitled folder” icon. This will open that folder. The win-
dow should now be blank (except for the items in the Sidebar and Toolbar).
This is because we simply “created” this folder — we haven’t stored anything
inside it. (Right now, this folder is stored inside your “Home” folder but we're
about to move it to a different folder.)

6 - Notice the tiny icon located to the left of the name of this window (in its Title-
bar). Move the mouse so the tip of the Pointer is over this icon. Now, hold
down the mouse button and drag this tiny icon to the Desktop (somewhere
outside of this window but not inside another window or folder).
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7 - You have just relocated this folder from the “Home” folder to the Desktop.
To verify this, click once on the “Home” icon, located in the Sidebar of that
window. Notice that the “untitled folder” is no longer there.

8 - As another step in this practice exercise, and to clean up the empty folder we
just created, open (double-click on) the “untitled folder” icon. (There won’t
be anything inside its window because we only created this folder, we never
stored anything inside it.)

9 - Using the technique in these steps, let’s move this folder to the Trash... Move
the mouse so the tip of the Pointer is over the icon in this window’s Titlebar,
hold down the mouse button and drag to the Trash. You have just relocated
this folder to the Trash.

NOTE: Asyou're dragging this icon, if you change your mind, simply press
the Escape key and this action will be stopped.
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If you press the Option key while dragging (start dragging and then press the Op-
tion key), you will make a Copy in the location you are dragging TO and the origi-
nal (the item in the location you’re dragging FROM), will remain where it was.

Comments:

As I mentioned in other parts of this book, examine the various components which
make up the various windows, dialog boxes, tool palettes, etc., that you encounter.
Most of the time, those triangles, vertical, horizontal and diagonal lines are actually
buttons or control manipulators.
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5j- The Titlebbar Icon: In Various Applications
Do:

While working in a program, notice the Titlebar icon located to the left of that
window’s name. If you’ve made changes to this document and haven’t saved the
file, this icon will be dimmed. Once it has been saved, it will be a bit brighter and
easier to see. You can also drag this icon to the Desktop or other Finder location
and it will make an Alias — dragging this icon with the Option key down will make
a Copy.
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This is what the Close button will look like
when there aren’t any changes to this document.

NOTE: Some programs do not have this icon feature. In the applications
which DO offer this feature, you must save the document at least
once before this icon will appear.

Don't:

Switching to the Finder in order to locate the file you are currently working in just
so you can make a Copy of it, can take longer than following this tip. Sure, you can
pull down the “File” menu, select “Save As...” and then locate the folder you want to
save a copy to but this can take more time than simply dragging the Titlebar icon to
a location you can see on the Desktop.
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Explanation:
Apple adds a lot of features to the Macintosh Operating System. Some of them are
not obvious at first glance. Apple also asks companies which make software for the
Macintosh to follow certain guidelines. These guidelines keep all your program’s
common elements (common with other programs) consistent. The icon, located to
the left of a window’s name (in its Titlebar) is such a feature. This icon is not simply
a “design element” (something pretty to look at). It actually provides two functions
— it becomes grayed out, to indicate “changes have been made and not saved” and
it allows you to drag it to another location to make an Alias or a Copy. Here are the
steps for dragging the Titlebar icon to a new location:
1- Move the Pointer so it’s over the Titlebar icon.
2 - Hold down the mouse button.
3 - Before dragging, be sure to wait (with the mouse button down) for a half-sec-
ond. The icon will then turn a dark gray — indicating it can now be dragged.
(If you don’t hesitate, instead of dragging the “icon” you’ll drag the “Titlebar”
— repositioning the window.) Once the icon is dark gray, you can drag it to a
new location (a folder or the Desktop, for example) or to another document
(in order to add this document’s information to that document).



NOTE: You can press the “Escape” key, if you change your mind and want
to stop this action; but if you hover over a Desktop window long
enough for it to come to the front, the “Escape” key will no longer
abort this process. In this case, drag this icon back to the Titlebar of
the window it came from.

Drag this icon

to the Desktop...

...without ...with the
any keys Option key
down (to down (to
make an make a copy)
Alias)

Desktop

When this icon is being used for feedback to see whether or not a document has
been saved, it can be very subtle and almost considered “eye candy”, but it is there
if you need it.

When using this same icon to make a Copy or Alias of that document, it can be a
very quick and easy solution to this situation.

Comments:

As I mentioned in other parts of this book, examine the various components which
make up the various windows, dialog boxes, tool palettes, etc., that you encounter.
Most of the time, those triangles, vertical, horizontal and diagonal lines are actually
buttons or control manipulators.
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Add TextEdit And Preview To The Dock
Sometimes you might receive a photo or document in an eMail message
which you cannot open. You double-click on the icon and a message ap-
pears asking which program should be used to view the file. After trying
several programs, you simply give up.

Apple includes two programs with each Macintosh: TextEdit and Preview.
They’re stored in the “Applications” folder. Drag each to the Dock and leave
them there for quick-access in the future.

These Apple-created programs can help you in several ways:

« TextEdit (a text-based program)
This is a word processing program. Not nearly as powerful as AppleWorks
or any of the others but still helpful. If you receive a text document you
cannot open, drag its icon to the TextEdit icon in the Dock and you’ll
probably be able to see its contents. TextEdit can open HTML, RTF, RTFD
and even Word documents. You can also use TextEdit to create a docu-
ment. When it comes time to save it, if you know you’ll be sending it to
someone who owns a PC (non-Macintosh computer), select “Word For-
mat” from the pop-out menu in the “Save As...” dialog box.

« Preview (a graphics-based program)
Although Preview doesn’t allow you to “create” your own drawings, it can
be very helpful in viewing and, in some ways, editing photos. Preview can
open and save several different formats: PDF, PNG, GIF, JPEG, TIFF,
Photoshop and a few more. So if you receive a photo you cannot open,
drag it to the Preview icon in the Dock and it will probably open. If the
document is a PDF you’ll be able to add notes and red circles to any part
of it. (This is helpful when more than one person provides creative input.)
If Preview displays a photo, you can use its controls to change exposure,
tint and other aspects.
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5k- Contextual Menus

Do:
Learn about “Contextual Menus” so you can see if they are something which may
help you from time-to-time.

Don't:
Performing a task which can be accomplished with a Contextual Menu option, may
be a waste of your time.

Explanation:
The “Contextual Menu” is activated by holding down the “Control” key (ctrl) and
then clicking the mouse button. This can be done in the Finder and most other
programs. Try it.
R Open

Open With »

Primt

Get Info

Move to Trash

Duplicate
Make Allas

M Create Archive of "Notes”
Copy “Notes”

A Contextual menu

Color Label
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Automator »
Enable Folder Actions

Configure Folder Actions..
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Notice that every menu item is NOT grayed out. A “contextual” menu is one which
only gives you the features which apply to your current situation. In other words,
if you’re in the Finder and Control-Click on a file’s icon, you’ll see: “Open”, “Move
to Trash”, etc. If you Control-Click and the Pointer is NOT on a file, folder or any
other icon, you may see a different list of menu options. In most programs, these
contextual menu items are the same choices which are listed in that program’s
pull-down menus. However, where some pull-down menu items can be grayed out
(or “disabled”), a Contextual menu’s items are NEVER disabled.

Dragging a file or folder across a 20-inch (or larger) screen, in order to move it to
the Trash, can mean extra work on your part and you risk the chance of dropping
that item into another folder. Use the Contextual Menu instead.

Contextual Menus can also come in handy if you have a Macintosh portable. Some-
times a Trackpad (non-mouse controller for the on-screen pointer) can be a bit
awkward to use. For example, why inch a file across the screen just to place it into
the Trash? Using the Contextual Menu for this is much faster and more efficient.

Comments:

As with pull-down menu shortcuts, Contextual Menus can be handy to some people
some of the time. You may enjoy using them ALL the time. If you check the Con-
textual Menu options on different features of a program, and in different programs,
you’ll begin to learn what they offer and how you can use them in various situa-
tions.



5L- Selecting Items In List View

Do:
If you want to select several files, folders or other items, place the Pointer within
the horizontal line of the first or last item and drag in the opposite direction.

Don't:

When you need to select several items which are next to each other, clicking them
one at a time, or even Shift-Clicking them one at a time, is a waste of your time.
Also, when you place the Pointer within the line of the first or last item, be sure it’s
not over a Folder Triangle, the icon or over any text. (Dragging a Folder Triangle
will not do anything. Dragging the icon or any text will Move that item to a new
location. If this happens and you don’t know how to put it back, or where it came
from, simply press the Escape key and this action will be stopped.

Explanation:

Placing the Pointer over the white area of an item, and dragging, will cause each
line the Pointer is within to become highlighted. This can be a fast way to select
several items at once. If you reach the top or bottom of that window’s edge, keep
dragging, but be sure the Pointer is within the white part of the window — below
the column titles (Name, Date Modified, Size, etc.) and above the bottom gray part
of that window.
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2 - You can begin drag?mg with
the Pomter in any of these
white (blank) areas. (Remember
to look for the largest target.)

Once you start dragging, you don’t have to drag straight down. If you think about
the next action you are going to perform, aim for that area whenever possible. If
you can think ahead to what’s going to happen next, and position the Pointer close
to that spot, you'll be even more efficient. For example... Let’s say you want to high-
light several items within a window because you want to know how much space,
together, they will take up. (Maybe you want to copy them onto a CD or Flash Drive
and want to know how much space they will occupy.) In this case, instead of start-
ing at the top of this window and dragging “down”, I would probably start at the
bottom and drag “up”. Then, without releasing the mouse button, I would move the
Pointer to the very top edge of the screen, slide to the left until the Pointer is over
the “File” menu. At that point, I would release the mouse button then hold it down
again. Now, drag down and select “Get Info”. (If you decide to release the mouse
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button before reaching the top of the screen, you will actually add a slight hesita-
tion to your movements and this will marginally slow down your overall efficiency.)
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After selecting these items, if your next step is to
pull down the “File® menu, drag up (making sure
the Scroll Box is now at the top of the Scroll Bar)
and then over to the "File® menu, When you release
the mouse button, immediately hold it down again
and the “File® menu will instantly pop down,

One other aspect I need to mention here is the use of the “Select All” feature. Be
sure the window you want to work in is active by clicking any part of it once. (Don’t
click on any of its buttons when doing this.) Then, pull down the “Edit” menu
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and choose “Select All”. When you do, ALL of the items (folders, documents, etc.)
within this window will be selected (highlighted).

If you want to select almost all of the items within a window, the “Select All” fea-
ture may be the fastest solution. Then, you can always de-select any items by Com-
mand-Clicking them.

" @ Finder File [FIY View Go Window

" Show Clipboard
i Special Characters...

One other way to highlight a large list of items is to click once on the first item
(probably at the top of the list) and then scroll down (if you need to) and, before
clicking on the last item in the list, hold down the “Shift” key. Now, when you click
once, every item between the first item selected and this one will be highlighted.
This technique also works with text...
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2 -~ Holding the Shift key down, click once
anywhere in this area, (Remember, always
look for the largest target.) All this text
will then be selected.

NOTE: If an item has been colored, its entire line will have that color for its
background. If that item is selected (highlighted), only a circle in
the Triangle column will be that color — whether there is a triangle
at that location or not. This can be confusing whenever you select
several items and then Command-Click to de-select one or more of
them. If any of these have a color applied, de-selecting it will cause
that color to appear. So instead of black text on a white background,
you’ll see black text on a red (or whatever color was used) back-
ground.
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cated to the left of a folder’s icon is called the “Disclosure Triangle”.
Clicking it will “reveal” or “hide” that folder’s contents. (The Disclo-
® sure Triangle is a toggle. If the triangle is pointing to the right, the
contents of that folder are hidden. If the triangle is pointing down-
ward, its contents are revealed and can be seen indented below it.

‘P TERMINOLOGY: “Disclosure Triangle” - In list view, the triangle, lo-




key and then click once on the Disclosure Triangle. To close this fold-
er and all its sub-folders, simply click its Disclosure Triangle without
® | pressing any keys.

' TIP: To open all the folders within a folder, hold down the Option

Remember, Option-Clicking a Disclosure Triangle will not reveal the contents of
every folder within that “window”. (It will reveal the contents of several folders
which are within that folder.) If this is what you want to do, you must first go back
a level to the folder icon represented by this window’s contents. To do this, do the
following:

1- Let’s say you want to reveal the contents of all the folders inside your “Docu-
ments” folder. Let’s also say you are now looking at the contents of your
Documents folder. We must first go back to your “Home” folder... Move the
Pointer so its tip is over the name of this window (look in the top-center of
this window for its name, “Documents”, in the Titlebar).

2 - Hold down the Command (Apple) key.

3 - Inthe pop-out menu that appears, notice that the top-most item (“Docu-
ments”) is the window you are currently viewing. Drag down one line so the
second-from-the-top item (your “Home” name) is highlighted and then click
once. You will then be viewing the contents of that folder or device (hard
drive, CD, DVD, Flash Drive, etc.). (In our example, you should now be view-
ing your Home folder.)

4 - Using the items within this window, locate the folder which was at the top
of that pop-out menu. (In this case, locate your “Documents” folder.) Hold
down the Option key and then click its Disclosure Triangle once. Every folder
within that folder will now reveal its contents.

Comments:

Think about which technique will help you the quickest. Sometimes you have to
combine techniques to get the best effect — and that’s fine. Remembering that
these techniques can be used in some other programs will also help you reinforce
these as habits.
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Understanding Mac OS X
If you previously owned a Macintosh which used Mac OS 9 (or earlier), the
basic rule was that you could place programs, folders and documents just
about anywhere you wanted. You could even poke around in any of its fold-
ers but it was a good idea to stay out of the “System Folder”.

With Mac OS X almost the opposite has happened... Mac OS X owns every-
thing and has given you one folder for all your storage needs. It’s referred
to as “Home”. Your documents should be stored in your “Documents”
folder, images in your “Pictures” folder, etc. You don’t “have” to do it this
way. This is just the way Mac OS X has set things up. Notice that even your
“desktop” lives inside a folder called “Desktop”. Everything currently sitting
on your Desktop is really inside this folder.

One bit of organization which Mac OS X really prefers that you follow is
to place all your programs in the “Applications” folder. It can more easily
update them because it knows where they are.

If you do need to place items in other areas, simply use an “Alias”. (Click
the icon once, pull down the “File” menu and choose “Make Alias”.)

The main rule to keep in mind while using Mac OS X is...

If you didn't create it, don't rename, move or delete it.

(This is so important, it should be printed on T-Shirts.)

In other words, if you add something to your Macintosh via eMail attache-
ment, CD, DVD or if you created the file in a program, you can name it
anything you like, place it in just about any of your Home folders (or sub-
folders) and you can even delete it. However, if you start looking inside
various folders you’ll find duplicates and items which you may think you
don’t need. These belong to Mac OS X and should not be tampered with.
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Do:
If you want to select several files, folders or other items, place the Pointer within
the horizontal line of the first or last item and drag in the opposite direction.

Don't:

When you need to select several items which are next to each other, clicking them
one at a time, or even Shift-Clicking them one at a time, is a waste of your time.
Also, when you place the Pointer within the line of the first or last item, be sure it’s
not over a Folder Triangle, the icon, over any text or over an already highlighted
item. (Dragging a Folder Triangle will not do anything. Dragging the icon, any text
or an item which is already highlighted will Move that item to a new location. If
this happens and you don’t know how to put it back, or where it came from, simply
press the Escape key and this action will be stopped.

Explanation:

Placing the Pointer over the white (blank) area of an item, and dragging, will cause
each line the Pointer is within to become highlighted. This can be a fast way to
select several items at once. If you reach the top or bottom of that window’s edge,
keep dragging, but be sure the Pointer is within the white part of the window — be-
low the column titles (Name, Date Modified, Size, etc.) and above the bottom gray
part of that window.
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2 - You can begin dragging with the
Pointer in any of these white (blank)
areas. The color on "Project-5" is a
Label color and still considered “blank”
for this technique. (Remember to look
for the largest target.)

Once you start dragging, you don’t have to drag straight down. If you think about
the next action you are going to perform, aim for that area whenever possible. If
you can think ahead to what’s going to happen next, and position the Pointer close
to that spot, you'll be even more efficient. For example... Let’s say you want to high-
light several items within a window because you want to know how much space,
together, they will take up. (Maybe you want to copy them onto a CD or Flash Drive
and want to know how much space they will take up.) In this case, instead of start-
ing at the top of this window and dragging “down”, I would probably start at the
bottom and drag “up”. Then, without releasing the mouse button, I would move the
Pointer to the very top edge of the screen, slide to the left until the Pointer is over
the “File” menu. At that point, I would release the mouse button then hold it down
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again. Now, drag down and select “Get Info”. (If you release the mouse button be-
fore reaching the top of the screen, you will actually add a slight hesitation to your
movements and this will marginally slow down your overall efficiency.
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After selecting these items, if your next step is to
pull down the "File” menu, drag up (making sure
the Scroll Box is now at the top of the Scroll Bar)
and then over to the “File” menu. When you release
the mouse button, immediately hold it down again
and the “File®™ menu will instantly pop down.

One other aspect I need to mention here is the use of the “Select All” feature. Be
sure the window you want to work in is active by clicking any part of it once. (Don’t
click on any of its buttons when doing this.) Then, pull down the “Edit” menu
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and choose “Select All”. When you do, ALL of the items (folders, documents, etc.)
within this window will be selected (highlighted).

If you want to select almost all of the items within a window, the “Select All” fea-

ture may be the fastest solution. Then, you can always de-select any items by Com-
mand-Clicking them.

" Finder Filem\flew Co Window

; ' Show Clipboard
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NOTE: When in “Column” view, if a folder is highlighted, when you “Select
All”, all of that folder’s “contents” will be highlighted (in the column
to its right). If a document is highlighted, when you “Select All”, all
of the items within that column will be highlighted.

One other way to highlight a large list of items is to click once on the first item
(probably at the top of the list) and then scroll down (if you need to) and, before
clicking on the last item in the list, hold down the “Shift” key. Now, when you click
once, every item between the first item selected and this one will be highlighted.

NOTE: If an item has been colored, its title line will have that color for its
background. If that item is selected (highlighted), only a circle in
the Triangle column will be that color — whether there is a triangle
at that location or not. This can be confusing whenever you select
several items and then Command-Click to de-select one or more of
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them. If any of these have a color applied, de-selecting it will cause
that color to appear. So instead of black text on a white background,
you’ll see black text on a red (or whatever color was used) back-
ground.
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NOTE: In “Column” View, clicking a Triangle will not do anything. This is
because Column View’s purpose is to always display the contents
of a selected folder — in the column to the right of it. The triangles
are here simply to provide quick feedback that this item is a “folder”
and not a “document” or a “program”.

Comments:

Think about which technique will help you the quickest. Sometimes you have to
combine techniques to get the best effect — and that’s fine. Remembering that
these techniques can be used in some other programs will also help you reinforce
these as habits.



5n- Selecting Items In Icon View

(This technique not only works in the “Finder” but also in “programs”. See “Select-
ing Objects” on page 136, for details.)

NOTE: When in the “Finder”, this only works while in “Icon” view. If you
are using “List” or “Column” view, see “Selecting Items In List
View” or “Selecting Items in Column View”.

Do:

When selecting more than a few folders, use the mouse to drag across them.

Don't:
When you need to select more than one folder at a time, especially a lot of folders,
clicking on each one individually is a real waste of time.

Explanation:

When working in the Finder (inside windows or directly on the Desktop), you can
drag across folders, documents and any other icon to select (highlight or choose)
one or more at a time. (These items are sometimes referred to as “objects”.)

In the Finder (within windows and on the Desktop), as you drag you’ll notice a
light gray filled rectangle. This is a “Selection Box”.
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highlighted (selected).

When “dragging across” objects, start by placing the Pointer outside the boundar-
ies of the objects but within the active window. If you make it a habit of starting
just outside the upper-left corner of the object, and dragging to the bottom-right
(in a diagonal direction), you’ll be faster and more efficient in no time.

NOTE: The main idea here is for you to be consistent when developing
this technique as a “habit”. Although you could start in any of the 4
corners, I've personally found it easier and more natural to “pull”
the mouse rather than “push” it. Pulling the mouse toward me and
to the right seems more automatic and natural than working in any
other direction. Try different start and end points, in a diagonal di-
rection, to see which you are most comfortable with. Once you find
the most automatic procedure, work it into this “habit”.



When the Pointer is in position, hold down the mouse button and drag to the bot-
tom-right — just outside the object’s boundaries. Release the mouse button. If you
drag past the boundaries of the window, it’s not a problem. You won’t accidentally
select something which is outside this window or inside a different window because
you “started” dragging within THIS window.

Now, let’s say you need to select most of the folders within a window. Using the
above technique will highlight all of the folders within the temporary Selection
Rectangle. That’s fine but in order to “de-select” (un-highlight) one or more of the
selected objects, you should simply hold down the Shift key and then click once on
each object which you DO NOT want selected.

NOTE: When de-selecting “Finder” items, be sure to aim for the “icon” not
the text beneath it. The icon is a larger target and clicking on the
text of a folder, document or program may highlight the text. If you
then press a key on the keyboard, that text will be replaced with that
key press.

The Shift key is a toggle, in this case. It allows you to “select” (add to the selected
group) or “de-select” (remove from the selected group) any objects you click on. So,
although you could have just Shift-Clicked only the objects you wanted to select,
since there were a large number which you DO want selected, you would be more
efficient if you dragged across the majority of them and then Shift-Clicked the ones
you DO NOT want selected.

One other aspect I need to mention here is the use of the “Select All” feature.

Be sure the window you want to work in is active by clicking any part of its gray
area once. (Don’t click on any of its buttons when doing this.) Then, pull down the
“Edit” menu and choose “Select All”. When you do, ALL of the items (folders, docu-
ments, etc.) within this window will be selected (highlighted).
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If you want to select almost all of the items within a window, the “Select All” fea-
ture may be the fastest solution. (Of course, if your non-mouse hand is hovering
over the Modifier Keys, you could quickly press “Command A”.) Then, you can
always de-select any items by Shift-Clicking them.

Knowing which technique to use is up to you and may be different each time. The
main thing to keep in mind is that there are ways to make your job easier. So,
before jumping in, even with a simple task such as selecting some folders, if you
take your time and think about the situation, you’ll be able to use the most efficient
technique for that particular purpose. After you do this several times, it will be
more natural and the right technique will simply be a matter of habit.

TARGET: Remember to look for the largest target area. This is where
you should initially place the Pointer.

Comments:

Make it a habit to start dragging from the upper-left but more importantly, be sure
to look for the largest area to use as your target. If you also remember to use the
“drag” and “Shift-Click” methods whenever appropriate, you'll be fast and accurate
in no time.
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Using Safari's Bookmarks
Safari, Apple’s web browser, allows you to organize your bookmarks in
three different areas: The Bookmarks menu, the Bookmarks Bar and the

Bookmarks page.

Although you can use these areas however you like, if you don’t group

your bookmarks into categories (folders), at some point you’ll be scrolling
through a long list of items every time you want to jump to one of your pre-
stored websites.

|!NA ot Blank
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33 MacCentral  MacSwrfer  MacOSrumars  VershionTracher  Mac »

The "Show all bookmarks”™ button

Click the “Show all bookmarks” button. On that page, you’ll be able to orga-
nize all three areas. Click the plus sign (+), located at the bottom of the left
column, to add a new category folder. If any folders appear in the Book-
marks Bar, that entry will have a triangle next to its name. Clicking this will
pop out a menu containing the contents of that folder.
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Selecting Objects

Closing versus Quitting

Keeping Track Of A Progress Bar

Locating A Folder While Opening Or Saving A File



6a- Three Ways To Scroll

Do:

Use the appropriate scrolling method whenever you want to scroll a window by the
height of a line of text, by the height of the window or by scrolling in larger incre-
ments.

Don't:
If you're reading text and it fills more than the height of the window, don’t keep
clicking the Down Arrow. You’ll waste a lot of time and tire out your eyes.

NOTE: If you don’t see Scroll Arrows, it’s because all the information for
that window fits inside its current size or because the bottom or
right edge of that window is off the right side of the screen.

Explanation:

There are three ways to scroll most any window. Keeping them in mind and know-
ing which to use with different situations will make you much more efficient, help
cut down on eyestrain and will keep you from losing your place, by scrolling too
much or too little.

NOTE: If you do not achieve the results mentioned below, check the scroll
settings in your System Preferences. Here’s where to find them:
1 - Pull down the “Apple” menu and choose “System Preferences...”.
2 - Click once on the “Appearance” icon.
3 - Normally, these are the settings...
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METHOD 1

Scrolling Text Increments

This method will allow you to scroll a window, up or down, the height of a typical

word — about 12-points (almost a quarter-inch). Here’s how to do it:

1- Notice the vertical bar at the right-edge of most scrollable windows. This is

called the Scroll Bar.
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2 - At the bottom of the Scroll Bar is a pair of Arrows — one pointing Up, the
other pointing Down. Clicking once on the Downward Pointing Arrow will ad-
vance the content of that window Up about one line’s height. Clicking on the
Upward Pointing Arrow will move the content of that window Down about
one line’s height. (The use of these Arrows seems a bit backwards. Think of
their use as... Clicking one of these Arrows means you want to see what’s in
that direction, so scroll it into my viewing area.)

If you're reading a long window-full of text, this is the worst method to use when
scrolling. Because this method only scrolls one line at a time, your eyes have to
constantly adjust to the fact that the bottom line of text has now jumped up one
line and your eyes have to move down and to the left to begin reading the next line.
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METHOD 2
Scrolling Window Increments

This method will allow you to scroll a window, up or down, by the height of that
window. Even if you resize the window, this method will still refer to that window’s
height. Here’s how to do it:

1- Notice the vertical bar at the right-edge of most scrollable windows. This is
called the Scroll Bar.

2 - Somewhere on that Scroll Bar is a blue bar or blue capsule. This is the Scroll
Box. Its size changes according to how much information this window con-
tains. The smaller the Scroll Box, the more content there is (which will not
currently fit within the visible part of the window). If you click once on the
part of the Scroll “Bar” which is “below” the Scroll Box, the content of that
window will scroll Up one window’s height. What was at the bottom of that
window is now at the top. If you click once on the part of the Scroll “Bar”
which is “above” the Scroll Box, the content of that window will scroll Down
on window’s height. What was at the top of that window is now at the bottom.
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Clicking the Scroll Bar here {(once) caused the contents

of this window to scroll up the height of the window.
(Notice the top line of text contains the word "Computer”.
In the previous image, this word was at the very bottom.)

When reading a long window of text, this is the best method for efficiently seeing
everything without losing your place or tiring your eyes.

METHOD 3
Scrolling Large Increments

This method will allow you to scroll a window, up or down, by huge amounts.
Here’s how to do it:

1- Notice the vertical bar at the right-edge of most scrollable windows. This is
called the Scroll Bar.

2 - Somewhere on that Scroll Bar is a blue bar or blue capsule. This is the Scroll
Box. Its size changes according to how much information this window con-
tains. The smaller the Scroll Box, the more content there is (which will not
currently fit within the visible part of the window). If you place the Pointer
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over the Scroll Box and drag it, up or down, you’ll be able to scroll past sev-
eral pages very quickly. Drag the Scroll Box to the very bottom and you’ll be
looking at the end of that document.

e0e . « Untitied.rtf .
Stves W) fEE E @ W Seaceg W) s W) » ¢ «o Scroll

t)rnnnnp;ggpjvsar
"I AOARR

- > - . 4 P — -

L

3 a 4 .
smply here a3 an esample. Computer

This text is pimply hate 85 an axampie . This St i mmply here a8 an example. This
Wl iy pimply hare

I roly hate &%

Sply hare &% 0 Thas et & Srrgly Boe 48 4N echesgie. This ot i
sirply here ks a0 Thas St o gy Bt 48 AN eccarpie. Thes ol is
Sty hate &t 0 This nl 8 Srrgly Bove 43 AN scarsdie. This ot i
STsly here k4 a0 . Thi St & Sy Dok 48 4N echrsgie. Ths ot i
Sly hate & a0 Thas saxt @ Sy Dot 43 AN examgie

Drag the Scroll Box up or down,
to move past several pages quickly.

Drag the Scroll Box to the very top and you'll be looking at the beginning of
that document. By the same token, if you drag the Scroll Box to the center of
the Scroll Bar, you'll actually be at the center of that document. (If it has 100-
pages, you should now be close to page 50.)

Comments:

Remembering the three scrolling methods will not only save you a lot of time but
also keep your eyes from tiring so quickly and you won’t lose your place when read-
ing long pages of text.



6b- Remembering Settings
Do:

Take a screenshot whenever you need to remember settings in a dialog box.

Don't:
Writing down settings can waste your time and may not be accurate when it comes
time to use them.

Explanation:

As you configure your new Macintosh, it’s a good idea to remember the various
settings for accessing the Internet, sending and receiving eMail, etc. However, one
dialog box alone could have either a lot of settings or some cryptic terminology
which may be impossible to remember. If you write this information down, you
risk the possibility of not copying it correctly and with LOTS of settings to remem-
ber, this can take you a lot of time.

The reason you should remember those settings is because you may have to reset
them in the future, should anything go wrong. It’s also a good idea because when-
ever you buy a new Macintosh you’ll already have most of what you need by simply
using those same settings. Granted, technology and terminology can change and

a new Macintosh may not use all those settings or may use different words but it’s
still a good starting point.

Instead of writing those settings down on paper, use the Macintosh to record that
information for you. This feature, which has been in the Macintosh for many, many
years, is referred to as a “screenshot”.

METHOD 1

Here’s how to perform a basic screenshot:
1- Hold down the Command key (also called the “Apple” key).
2 - While holding that key down, also hold down the Shift key.
3 - While both of those are down, touch the number “3” key. Once you touch the

(1P

3” key, release all three keys.
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2 - Touch the number "3" key, then release all three keys.

S N P S S S S

1 - Hold down the Command and Shift keys. Courtesy of Apple

At that point, you should hear the sound of a camera shutter clicking once.
Everything you saw on the screen (the entire screen) was copied and saved to
the hard drive in one file called “Picture 1”.
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PNC

Picture 1

4 - Look on the Desktop and you should see a file called “Picture 1”. (If you can’t
see the Desktop click the “Finder” icon in the Dock and a window will open.
Click the “Desktop” button in the Sidebar (located on the left side of that win-
dow). Now you should see “Picture 1”.)

5- Double-click on the “PIcture 1” icon and it will open (probably in Apple’s
“Preview” program).

METHOD 2

Here is a more-exact alternative to using Command Shift 3:
1- Hold down the Command key (also called the “Apple” key).
2 - While holding that key down, also hold down the Shift key.
3 - While both of those are down, touch the number “4” key. Once you touch the
4 key, release all three keys.
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2 - Touch the number "4" key, then release all three keys.
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1 - Hold down the Command and Shift keys. Courtesy of Apple
At that point, the Pointer will change into crosshairs — a large “plus sign”
with a small gray-colored disk in the center.

+

This is feedback telling you it’s ready to capture (make a copy of) any part of
the screen you drag across.

Now, move the mouse so the center of the crosshairs is at the upper-left cor-
ner of what you want to take a picture of.

Hold down the mouse button and drag diagonally to the bottom-right of the
area you want to capture.

NOTE: If you change your mind during steps 4 and 5, simply press the

6 -

4_

“Escape” key to stop it.

When you release the mouse button, you should hear the sound of a camera
shutter clicking once. Everything you just dragged across was copied and
saved to the hard drive in a file called “Picture 1”.

5@3.

PNC

Picture 1

Look on the Desktop and you should see a file called “Picture 1”. (If you can’t
see the Desktop click the “Finder” icon in the Dock and a window will open.
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Click the “Desktop” button in the Sidebar (located on the left side of that win-
dow). Now you should see “Picture 1”.)
5- Double-click on the “PIcture 1” icon and it will open (probably in Apple’s
“Preview” program).

METHOD 3

Here is a more-exact alternative to using Command Shift 4. Let’s say you specifi-
cally want to make a copy of one window or dialog box. This method is the one to
use. It’s faster and more accurate than the other two. Here’s how to do it:
1- Hold down the Command key (also called the “Apple” key).
2 - While holding that key down, also hold down the Shift key.
3 - While both of those are down, touch the number “4” key. Once you touch the
4 key, release all three keys.

r 2 - Touch the number "4" key, then release all three keys.
—— i
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1 - Hold down the Command and Shift keys. Courtesy of Appie

At that point, the Pointer will change into crosshairs — a large “plus sign”
with a small gray-colored disk in the center. (This is where the steps in
“Method 27, above, end. Now we’re going to add another keystroke before do-
ing anything else.)

4 - Press the “Spacebar” once.
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3 - Now press the Spacebar once. Courtesy of Appie

When you do, those crosshairs (representing the Pointer) will change into a
camera.

This is feedback telling you that it will take a picture of any window or dia-
log box you click on. It will even take a picture of the current Desktop image
— but not the icons or windows sitting on it.

5- Move this Pointer around the screen. As it passes over a window, dialog box
or the Desktop, that area will become highlighted.

NOTE: If you change your mind from the end of step 3 through step 5, sim-
ply press the “Escape” key to stop it.

6 - When you click the mouse button, you should hear the sound of a camera
shutter clicking once. The window you just clicked on was copied and saved to
the hard drive in a file called “Picture 1”.

9:@3_

PNC

Picture 1

7 - Look on the Desktop and you should see a file called “Picture 1”. (If you can’t
see the Desktop click the “Finder” icon in the Dock and a window will open.
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Click the “Desktop” button in the Sidebar (located on the left side of that win-
dow). Now you should see “Picture 1”.)

8 - Double-click on the “Plcture 1” icon and it will open (probably in Apple’s
“Preview” program).

NOTE: If you take another screenshot, the file will be called “Picture 2”.
This continues in sequence... “Picture 3”, “Picture 4”, and so on. So,
if you double-click on “Picture 1” but do not see the same images
as when you took the screenshot, it is probably because a “Picture
1” file was already on the Desktop. In this case, look for “Picture 2”
, “Picture 37, etc. (The last screenshot taken will have the highest
number in its name.)

No matter how you took the screenshot, be sure to rename those “Picture” files so
you will know what they represent and then back them up outside the Macintosh
(perhaps onto a CD or DVD).

Comments:

Make Command Shift 3 and Command Shift 4, with and without the Spacebar, a
part of your “habit” tools. These can come in handy for preserving all sorts of infor-
mation — both text-based and graphic-based.



6c- Saving Text Snippets
Do:

Anytime you want to make a copy of a few words or a few paragraphs, highlight
that text, then drag it off to the Desktop.

Don't:

Copying a small amount of text or even using the Mac’s built-in “Services” menu
(under the Application menu, located to the right of the “Apple” menu,) is not as
fast as this “drag and drop” method.

Explanation:
Sure the Copy/Paste method or even Apple’s “Services” function will allow you to
place highlighted text in a specific document but sometimes you simply want some-
thing quick. Maybe you don’t need to add the new text to an existing compilation.
Perhaps you just want to temporarily remember a technical term, a phone number,
etc. Here’s how to do it:
1- Resize and/or move any windows or dialog boxes so you can see the text you
want to copy AND a blank (empty) part of the Desktop at the same time.
2 - Highlight the text you want to copy. (Remember to look for the “biggest tar-
get” and drag from that area. This habit will save you time.)
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3 - Move the Pointer so it’s over any part of the highlighted text. (Again, aim for
the largest target.)
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4 - Hold down the mouse button and pause slightly (maybe a half-second) and
then drag to the Desktop and release the mouse button. A file will appear,
called a “Clipping” or “Text Clipping”. (Most programs require a slight pause.
However, some do not but if you always pause, as a habit, you won’t have any
problems. Of course, if you are going to do a lot of copying in this way and
you know the program you are working in does not require that pause, then
you really should avoid it — your copying will go even faster!

NOTE: If you change your mind at any time, before releasing the mouse
button in Step 4, simply press the “Escape” key to stop this func-
tion.

NOTE: This technique will also work if you want to drag the text to an
existing document. However, the destination document has to be
open before beginning with these steps. Just substitute “your docu-
ment” whenever “Desktop” is mentioned in Steps 1 and 4 above.
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NOTE: Although some programs will not allow you to perform this tech-
nique, it should work in every place you find “text”, including dialog
boxes. (Here “text” refers to true letters and numbers and not some
of the “graphic-based” or “Flash-based” text you sometimes find on
web pages. You’'ll know it’s graphic-based or Flash-based because
you won't be able to highlight individual characters.

Comments:

For a direct copy of text from the source to the destination, this method is the fast-
est.



6d- Selecting Objects

(This also works in Finder windows. See “Selecting Items In Icon View” on
page 114)

Do:

When selecting more than a few objects, use the mouse to drag across them.

Don't:
When you need to select more than one object at a time, especially a lot of objects,
clicking on each one individually is a real waste of time.

Explanation:
In programs which deal with various working components as “objects”, you can
usually drag across them to select (highlight or choose) one or more at a time.

NOTE: This will not work in photo-retouching programs such as Adobe
Photoshop or paint-oriented programs such as Corel Painter be-
cause these programs maintain your images at a “pixel” (or “dot”)
level and not an “object” level.

In the Finder (within windows and on the Desktop) and those programs which
allow you to drag across objects, as you drag you’ll notice a light gray filled or an
outlined rectangle. This is a “Selection Box” (or “Selection Rectangle”).

When “dragging across” objects, start by placing the Pointer outside the boundar-
ies of the objects but within the working page. If you make it a habit of starting just
outside the upper-left corner of the object, and dragging to the bottom-right, you’ll
be faster and more efficient in no time.

NOTE: The main idea here is for you to be consistent when developing
this technique as a “habit”. Although you could start in any of the 4
corners, I've personally found it easier and more natural to “pull”
the mouse rather than “push” it. Pulling the mouse toward me and
to the right seems more automatic and natural than working in any



Selecting Objects - 6d 135
other direction. Try different start and end points to see which you
are most comfortable with. Once you find the most automatic pro-
cedure, work it into this “habit”.

When the Pointer is in position, hold down the mouse button and drag to the bot-
tom-right — just outside the object’s boundaries. Release the mouse button. If you
drag outside the boundaries of the page, it’s not a problem because only the objects
within that window will be affected (selected).

a0 6 wntitied (DR)
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1 - Start dragging 2 - Drag to the
from the lower-right.
upper-left,

NOTE: Some program require that the Selection Box “surround” the ob-
jects, in order to select them. Other programs allow you simply
“touch” the objects with the Selection Box.

Now, let’s say you need to select most of the objects on a page. Using the above
technique will highlight all of the objects within the rectangle you create while
dragging. That’s fine but in order to “de-select” (un-highlight) one or more of the
selected objects, you should simply hold down the Shift key and then click once on
each object which you DO NOT want selected.



The Shift key is a toggle, in this case. It allows you to “select” (add to the selected
group) or “de-select” (remove from the selected group) any objects you click on. So,
although you could have just Shift-Clicked only the objects you wanted to select,
since there were a large number which you DO want selected, you would be more
efficient if you dragged across the majority of them and then Shift-Clicked the ones
you DID NOT want selected.

One other aspect I need to mention here is the use of the “Select All” feature, found
in most programs. Pull down the “Edit” menu and choose “Select All”. When you
do, ALL of the items within that document (on all of its pages) will be selected
(highlighted).
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If you want to select almost all of the items within a document, the “Select All” fea-
ture may be the fastest solution. Then, you can always de-select any items you don’t
need by Shift-Clicking them.

Knowing which technique to use is up to you and may be different each time. The
main thing to keep in mind is that there are ways to make your job easier. So, be-
fore jumping in, even with a simple task such as selecting objects, if you take your
time and think about the situation, you’ll be able to use the most efficient technique
for that particular purpose. After you do this several times, it will be more natural
and the right technique will simply be a matter of habit.

TARGET: Remember to look for the largest target area. This is where
you should initially place the Pointer.

Comments:

Make it a habit to start dragging from the upper-left but more importantly, be sure
to look for the largest area to use as your target. If you also remember to use the
“drag” and “Shift-Click” method whenever appropriate, you’ll be fast and accurate
in no time.
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This page was going to be blank but we rescued it by adding a
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Avoiding More Suspicious eMail
When reading eMail titles in Apple’s “Mail” program, if you see a suspicious
item it’s best to delete it without even opening it. If you leave the Divider
Bar up, clicking once on a message title will open that message. If that mes-
sage has been programmed to send a note back to the sender upon opening,
you have just triggered this event and the sender now knows he or she has
sent that message to a real person. Criminals use special programs to gen-
erate eMail addresses. These are then sent out and they may have no way of
knowing which belong to real people until one is opened. Then they’ll start
sending you more. Avoid this by dragging or double-clicking the Divider
Bar. Once the bar’s at the bottom, clicking on a message will not open it. If
you want to leave the bar down all the time, simply double-click any mes-
sage you DO want to read and it will appear in its own window.
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6e- Closing versus Quitting

Do:
Whenever you have finished using a program, pull down its “Application” menu
and select “Quit”.

Don't:
Closing a program’s window doesn’t “Quit” (or exit) that program. It still uses RAM
(temporary workspace) and occupies some of the Mac’s resources.

N e Untitled

d The green "Resize” button
The yellow "Minimize™ button

The red "Close”™ button

Explanation:
I've seen lots of Macintosh users do this as a habit, without thinking... They’re fin-
ished with a program, such as TextEdit, so they click the “Close” button.

Yes, this does remove the window they were just working in but the program itself
is still open, in RAM. Although Mac OS X manages RAM very well and even though
a program such as TextEdit doesn’t take up much RAM, it still keeps this RAM
from being used by another program — which may need it. If you continue to do
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this as a habit, at some point you will have several programs open (some of which
may consume a lot of RAM) and then your Macintosh will become a bit sluggish.
This may also keep you from opening yet another program or may keep you from
Copying a large block of text or a photo.

There are three ways to quit a program. Use the method which is best for your situ-
ation...

METHOD 1

Pull down the “Application” menu and choose “Quit”.

S RCLCHE File Edt Format Window MHelp
2 1) About TextEdit

Preferences... X,
Services »

Hide TextEdit XM
Hide Others \2H

METHOD 2

Use the “Command Q” keyboard shortcut. While you’re in the program you want to

({2

exit, simply hold down the Command key then press the letter “q” and release both
keys. This will remove that one program from RAM.
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METHOD 3

Use the program’s Dock menu. Move the Pointer to the Dock. Place it over the icon
of the program you want to quit.
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Comments:
No matter which method you use, when you have finished with a program be sure

to quit it. This will also close all of its associated tools, palettes, windows, etc.



6f- Keeping Track Of A Progress Bar
Do:

When downloading a file, installing software or any time you see a Progress Bar,
move the Pointer so it’s tip is just at the right-edge of that growing blue bar.

Don't:
When a Progress Bar appears, don’t watch it endlessly, waiting to see if it’s ever go-
ing to move.

Explanation:

A “Progress Bar” is usually a horizontal, blue bar found in an alert box or dia-

log box and gives us feedback as to how long a task is going to take by its length.
Sometimes a Progress Bar moves so slowly, it’s nearly impossible to notice when
it moves. Sometimes a task may become stuck. If a Progress Bar is providing feed-
back for this activity, it may stop moving... but how will you know?

Instead of staring at that Progress Bar, simply use the Pointer as a placeholder.
Move the mouse and position the Pointer so its tip is at the right-edge of the blue
Progress Bar.

Repairing permissions S

Now, if you don’t move the mouse, the blue bar will eventually inch its way past
the Pointer. If it does, then this task really is being worked on by your Macintosh.
On the other hand, if that task doesn’t usually take very long and the Progress Bar
doesn’t cross under the Pointer after several minutes, chances are this activity is
stuck.
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NOTE: If a task, such as one represented by a Progress Bar, really gets
stuck, you can halt this process by pulling down the Apple menu,
choosing “Force Quit”, choosing the “stuck” program from the list
which and clicking the “Force Quit” button.

Comments:

When waiting for a Progress Bar to slowly inch along, especially when it’s so slow
you don’t notice it moving, place the Pointer next to the edge of this bar. If the bar
moves, its edge will be further-right than the Pointer.



6g- Locating A Folder While Opening Or Saving A File
Do:

While in a program, if you need to open or save a document and can’t remember
where a specific folder is located, enter that folder’s name (or part of its name) into
the search field or the “Open” or “Save” dialog box.

Don't:

When saving or opening a file, don’t dismiss the “Open” or “Save” dialog box and
start sifting through folders on the hard drive, if you can’t remember where a cer-
tain folder is. A fast, efficient helper is right there at your fingertips.

Explanation:
In every “Open” and “Save” dialog box, you’ll find a “Search Field” — that narrow
text box which displays the word “search”.
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Click once in this “Search” field and the
“Blinking, Insertion Point will apgear.
Enter the text you want to search for
then Press "Return”.

NOTE: If you don’t see the Search field in a “Save” dialog box, it could be
because this dialog box is “collapsed”.
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If this is your view of the "Save” dialog box,
click this button and you'll see more options.

If this is the case, you can “expand” that dialog box (and see all of its options) by
simply clicking once on the downward-pointing triangle located to the right of the
“Save As:” field.
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nee Uncaled

Save As: Untitied.rtf ‘el

‘e » ! '@ [ Yool ) Q search

L3 Notes Tor Project-1 %\ 0 vy for book raf

® My GS

® Ok |4 Notes for Progect-31  » L) Software

“ k C"-.'.' .?‘

2 Macieresh HD o Projecs-1
|4 Projects-2

BB Oesk10p T L Projecrs-3

T Home |4 Projecty-4 - L

A Asglicatons L) Projecis~S > 2

J scracules . [ |
e

LI Freeway-Sees | |} -

File Format  Rich Text Format (RTF) ;’
_ Hide Extension  ( New Folder | [ Cancel | £ Save )

This Search field is a part of “Spotlight”, Mac OS X “Tiger’s” (10.4) search fea-
ture. This is a “live” search. Which means the Macintosh will begin searching the
hard drive, CD, (whatever is attached or inserted) etc., as soon as you start typing
— there’s no need to press the Return key. The far-left column in this dialog box is
still called the “Sidebar” — just as it is when you’re in the Finder. The next column
to the right is where you’ll find the search results.
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Searched for this text, in this "Save As..." dialog box.
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Here are the results of that search,

Normally, the items listed in any column (of “Column View”) are the contents of
a specific folder or disk. When using the Search field, however, the items in this
column may be stored in different folders and disks.

While in the “Save As...” dialog box: Scroll through the results column and if you
see the item you're looking for, click it once. If it’s a “folder”, it’s contents will be
displayed in the normal manner — in the column to its right. Then continue using
this dialog box as you normally would.
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While in the “Open...” dialog box: If the item you’re looking for is a document or
photo, double-clicking its icon will open it.

Comments:
Using this feature of Mac OS X 10.4 is a very fast and efficient way to find what
you’re looking for without switching to the Finder and poking through folders.
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Protect Your Mac From Bad Electricity
Although you may have heard that you should have your Macintosh con-
nected to a surge protector, this is not the best type of electrical protection.
At the very least, you should be using a “guaranteed” surge protector and
it should be connected directly to a “grounded” electrical outlet. (“Guaran-
teed” means the manufacturer will pay a certain dollar amount to repair
or replace any equipment which is damaged by too much electricity, when
connected to their unit.)

Even with these precautions, there is one type of electrical situation which
no “surge protector” will work and that is when there is “no” electricity. If
the electricity goes OFF, even for a split-second, the Macintosh could have
been in the middle of a behind-the-scenes task and some of that informa-
tion has now become corrupted (mixed up). Over time, this can cause more
and more problems until one day when your Macintosh may refuse to start.

To prevent this, it’s a good idea to invest in a “UPS” — Uninterruptible
Power Supply. It’s like having a surge protector with a battery. The ones
we’ve been using here for many years are made by APC (American Power
Conversion, www.apc.com). Their units are guaranteed and work like a
charm.

When buying a UPS, check the APC website to see which UPS will work for
your particular configuration of Macintosh, monitor, printer, scanner, etc.
Be sure to also protect your Cable, DSL or telephone modem by connecting
a cable between the wall outlet provided by your Internet Service Provider
and the UPS. Then use another cable from there to the Macintosh.
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7a- Dragging An Item To A Folder
Do:

If you drag a document, program or folder to a folder and it just sits there, because
it didn’t quite go inside the folder, drag that item a few inches away, drop it and
then start over.

Don't:
If an item you're dragging falls short of actually going inside a folder, don’t keep
dragging it that last quarter-inch or so. This will waste a lot of your time.

Explanation:

Sometimes, when working in “Icon View”, document, program and folder icons can
be placed so close to each other that they look as though they’re stacked on top of
one another — like the document and folder icons below.

(=
4

U

Notesdiectsaak.rtf

—

If two or more icons are positioned too close together and you continually click, in
order to select the one you want, you’ll end up frustrated most of the time.

Instead, drag whichever icon you happen to select to the largest empty space within
the same window. (You can drag this item to another window or to the Desktop but
it’s easier to keep track of if you can stay within the same area.) Now that the items
are separated in an obvious way, you can more directly drag the one you really
want to its proper destination.

In the above example of the “folder” and “document” icons, let’s say we want to
select the document icon but each time we try we select the folder.
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1 - Drag the folder
icon to a blank area.

Drag the “folder” icon to a new, blank location.

_L
®

Notes for book

U

Projects- l

2 - When you do,

you'll be able to
easily select the
document icon.

At that point, the “document” icon will no longer be hidden and can easily be se-
lected and moved.



Comments:

Get into a habit of always looking for the largest “target” — a large white or blank
area in a window or on the Desktop. Dragging a miss-purposed item to the largest
target area is a very quick way to clear the area you are working in. Then, by start-
ing over from this new position, you’ll be more efficient because you will now be
focusing more on this one task.
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Reading Small Text
Sometimes it’s difficult to read text on the screen because the font (type-
face) is so small. If you're in Apple’s “Mail” or “Safari” programs, there’s
a feature which you can add to the tools at the top of their windows which
will come in handy.

Mail

Pull down the “View” menu and choose “Customize Toolbar...”. A sheet of
buttons will appear. Look for the one labeled “Smaller Bigger” and drag

it just above this sheet to this window’s Toolbar. Then release the mouse
button. Click the “Done” button when you're finished. Do the same thing
in the composing window. Click once on the “New” button in the Toolbar.
Now, repeat the above steps and add the “Smaller Bigger” button to this
window.

Safari

The same can be done in Safari but two of the terms are different... Pull
down the “View” menu and choose “Customize Address Bar...”. A sheet
of buttons will appear. Locate the one labled “Text Size” and drag it up to
Safari’s Address Bar. Release the mouse button and click the “Done” but-
ton when you’re finished.

Now, anytime you’re in either of these programs and find the text too small
to read, simply click on the large “A” button. If it’s still not large enough,
keep clicking until it is.



158 Finder Efficiency

7b- Separating Cluttered Icons

Do:
While in “Icon View”, if you have a window or Desktop with lots of icons or they

simply look cluttered, use the “View” menu’s “Arrange By” feature to quickly orga-
nize them.

Don't:

If you're using “Icon View” and you need to locate a specific item, or just want them
all to be a little more organized, don’t waste your time dragging or reading them
one by one.

Explanation:
METHOD 1
The Macintosh Operating System (Mac OS X), has a built-in feature which can help

you quickly organize the files, folders and programs of “Icon View”. This can be
done manually by doing the following:

1- Let’s make sure you're in the “Finder”. Look in the Dock and click once on the
“Finder” icon. (It’s the one with the dark-blue / light-blue face. (When you're
in the Finder, you see the name “Finder” at the top of the Application menu
— located to the right of the Apple, in the menubar at the top of the screen.)
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2 - Before you can organize your icons, you have to tell the Macintosh what area
you are going to work in. If you want the items on the Desktop organized,
click once on any blank (unoccupied) part of the Desktop. If you want the
items within a specific window to be organized, click once on that window.

NOTE: If you want to organize the contents of a folder, double-click on it.
Whenever a folder is open, its contents are displayed within a “win-
dow”. We can also say this the other way around, just for clarity...
Whenever you are looking at a “window”, you are either looking at
the contents of a “folder” or of a CD, DVD, hard drive, Flash Drive,

ete.
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3 - After clicking, to indicate which window (or the Desktop) you want to work
on, pull down the “View” menu, scroll down to “Arrange By” and then slide to
the right and choose one of the options in the sub-menu. All of the document,
folder and program icons, within that area, will now be organized.

" @& Finder File Ecn [JIENY Co window Help
F

v as lcons Xl
.‘; as List x2
as Columns M3
0’ Cliean vo
Arrange By 9 »
@ Hide Toolbar NHT
Customize Toolbar ...
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—.7 Hide View Options X
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NOTE: If the “Arrange By” option, in the “View” menu, is grayed out (dis-
abled), it’s because the window (or Desktop) you're trying to orga-
nize already has an automatic aligning feature applied to it. (See
“METHOD 2” below.)

METHOD 2

Another way to organize your “Icon View” items is to have the Macintosh do it for
you all the time, automatically. Here’s how to do set it up:

1- Let’s make sure you're in the “Finder”. Look in the Dock and click once on the
“Finder” icon. (It’s the one with the dark-blue / light-blue face. (When you're
in the Finder, you see the name “Finder” at the top of the Application menu
— located to the right of the Apple, in the menubar at the top of the screen.)



2 -

Before you can organize your icons, you have to tell the Macintosh what area
you are going to work in. If you want the items on the Desktop organized,
click once on any part of the Desktop. If you want the items within a specific
window to be organized, click once on that window.

After clicking, to indicate which window (or the Desktop) you want to work
on, pull down the “View” menu and choose “Show View Options”. If you're
working in a window (not the “Desktop”), be sure to click the “This window
only” button, located near the top of the dialog box that appears. (Of course,
if you do want these settings to apply to EVERY window, then click the “All
windows” button.)
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You can experiment with the various features this dialog box offers but the main
“automatic organization” features you’ll want to think about are:

"Snap to grid” Setting
| lcon View - Clutter Examples

b B B B B B B B KB __E __E _E __E __J
\ ’ ) :
E

I 800k Images t-‘

e
L ]

13 karn, 3741 G2

Notice these icons are
The "Snap to grid” icon aligned but not alphabetized.

« Snap to grid: Selecting this feature will place a tiny 3 by 3-square grid in the
bottom-left corner of that window. (This is feedback. Any window you see this
on will have that feature activated.) All the items within that window will line
up to an invisible grid. One problem with this feature is that it is still possible
to place one icon directly on top of another. However, if you're careful when
dragging items within this window, the “Snap to grid” feature can help you
organize those items and it will allow you to use your own method of which
items should be place next to each other. Another problem with this feature
can be seen when you resize that window. Drag the bottom-right Resize box
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and notice that the icons stay put — they don’t realign themselves whenever
the window becomes larger. This isn’t the most efficient organizational tool
but it can still come in handy at times.

"Keep arranged by” Setting
- ' W‘-O e e

r---- - -

o5 for Progect-3 Projecrs- 1

13 mems, 97.41 GR

Notice tse ons are
The "Keep arranged by” icon now alphabetized.

» Keep arranged by: Selecting this option will place a tiny 2 by 2-square of dots
in the bottom-left corner of that window. (This is feedback. Any window you
see this on will have that feature activated.) All the items within that window
will ALWAYS line up to an invisible grid based on the criteria you choose in
the pop-out menu, located just under the words “Keep arranged by”.
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0 kon View - Clutter Exampies
@ This window only
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Kind

Label

Because this method engages an “automatic” organizer (on the Desktop or
one or more windows), you will not be able to “manually” set the “Arrange
By” feature in the “View” menu.
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In fact, if a window (or the Desktop) has one of these automatic organizers applied
to it, the “Arrange By” option in the “View” menu will be grayed out (disabled).

Comments:

These techniques can be a very quick, efficient and powerful way for you to keep
one or more windows (and the Desktop) organized. They can also come in handy if
you find icons stacked on top of one another or if an icon seems to be off the edge
of the Desktop and you just can’t quite click on it to drag it back.
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Other Instructional Resources
Besides taking classes at your local community college, here are a few other
resources for you to consider...

« Join a Macintosh user’s group. Even if they don’t offer formal “classes”,
it’s still a good way to ask questions and learn what others consider worth-
while books and training videos.

» Generally, for books which are fairly well-written, you won’t go wrong by
starting with Peachpit Press books (www.peachpit.com). Specifically, if
you want to know that a particular author is very good every time, your
best bet is Robin Williams (not the comedian). She’s been a Peachpit
Press author for many years now and really knows her stuff.

« Some websites offer online Macintosh instruction. Although I don’t know
how good they are, here are just a few I've found. Some also offer CD- or
DVD-based training materials:
eee http://www.apple.com/training
ee« http://www.macacademy.com
ee+ http://www.atomiclearning.com
eee http://www.lynda.com
eee http://www.totaltraining.com
ee« http://www.digitalmediatraining.com
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8a- Set The Mouse Speed
Do:

If you feel you're faster than the Macintosh allows you to move the Pointer across
the screen, it may be time to increase the mouse speed.

Don't:

If you feel a bit frustrated while working, but don’t quite know what could be at
the root of this, take a closer look at whether you're struggling getting the Pointer
where you need it or whether you know you can anticipate your next mouse click
but cannot get the Pointer to that spot quickly enough. If either of these is the case,
you may be working too hard.

Explanation:
Usually, when we first start working with a new Macintosh, the computer “feels” as
though it’s FAST... “Wow, this is great! This new Mac is much faster than my old

”»

one.

This happens because your new Mac IS faster than your old one. However, the
more you use this new Mac the more you become adjusted to its speed. After a
while, and without realizing it at first, you actually start to anticipate the Mac’s
speed and, at some level, can “feel” or “sense” just how fast it’s supposed to be. Af-
ter this happens, we use this new Mac in a sort of speed “comfort zone”.

Granted the Macintosh can become a bit slower over time, due to the way we’ve
organized our documents, photos, etc., or because there’s not enough RAM for

the things we want to do, or a few other reasons we won’t get into here. Even with
optimal use of the Macintosh, after the “comfort zone” period, you can begin to feel
that this “new” Macintosh is now slower than you remember... “It’s slowed down.
When I first bought it, it was really fast.”

Besides adding more RAM and taking better care in the organization of your docu-
ments, increasing the mouse speed can have a dramatic effect on your productivity
— at least until you hit another “comfort zone” with this new speed. Here’s how to
change the mouse speed:
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1- Pull down the “Apple” menu and choose “System Preferences”.

enn Syrtem Preferences
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2 - Click once on the “Keyboard & Mouse” icon.
3 - Click once on the “Mouse” Tab, located near the top portion of this dialog

box.
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enn Keydoard & Mouse
|‘ » ‘c SMM | ‘Q!

' Keyboard -‘M.* Buetooth  Keyboard Shortcuts

Tracking Speed Double-Click Speed
Low Fast S Fast
Double-click here to test
To change how the To change how the
mouse responds to mouse responds to
movement”, adjust double~clicking”,
these settings. adjust these settings.

{

)
-~
o’

4 - Change the sliders in the “Tracking Speed” and “Double-Click Speed” sec-
tions.

“Tracking Speed” is the setting for how far the Pointer will travel when you move
the mouse.

“Double-Click Speed” is the setting for how fast you must press the mouse but-
ton, in order to initiate a second click, after the first click is finished. Remember, a
“click” consists of two parts — pressing the mouse button DOWN and then releas-
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ing the mouse button so it returns to its UP position. (Simply holding the mouse
button DOWN, initiates a “Drag” and is not considered a “Click”.)

Comments:

Whenever you feel your Macintosh is “slowing down” or if you're tired and looking
for anything which will boost your “efficiency”, try changing the mouse speed and
click speed settings.



8b- Set The Pointer Size

Do:
Go into System Preferences and set the Pointer to a size which is more comfortable
for you.

Don't:
If you find yourself trying to locate the Pointer from time-to-time, you’re wasting
time. The Macintosh has a built-in way to help you be more efficient.

Explanation:
Whether it’s because of eyesight, being tired, glare on the screen or other work-
place conditions, you may find yourself searching for that tiny black arrow which is
controlled by the mouse — called a “Pointer”. If you find yourself in this situation,
even temporarily because of a tiring work day, stop straining your eyes and wasting
your time. Here’s how to change the size of the Pointer:

1- Pull down the “Apple” menu and choose “System Preferences”.
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2 - Click once on the “Universal Access” icon.
3 - Click once on the “Mouse” Tab, located across the top portion of this dialog

box.
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enn Universal Access
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4 - Here, you'll find slider next to “Cursor Size:”. As you drag this slider notice
that the Pointer will change size.

Comments:
Change the Pointer size either permanently or whenever you need to get through
the last few hours of a project more efficiently.
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Having The Mac Automatically Open Programs
If there is a program or document you use most often, add it to “Login
Items” in “System Preferences”. This can be especially handy if you want to
start your day by checking your eMail. Add the Mail program to the Login
Items list and whenever you turn ON your Macintosh or Log In to your Mac
OS X account, the Mail program will automatically open.

To add items to your “Login Items” list do the following:

1 - Pull down the Apple menu and choose “System Preferences...”.

2 - Click once on “Accounts”.

3 - Click once on “Login Items”, located near the top-middle.

4 - Near the bottom-center, you’ll see a plus sign (+), click it once.

5 - In the dialog box that appears, locate the item you want to add. Click its
name once then click the “Add” button. (You may be asked to enter your
password, in order to make any changes. That’s fine.)

6 - Pull down the “System Preferences” menu and choose “Quit System
Preferences”.

That’s it! The next time you turn ON, Log In or Restart your Macintosh,
that document or program will appear without you doing anything extra. Of
course, if you want several items to open automatically on startup, just add
them to this list.



8c- Set The Keyboard "Delay” Speed

Do:
When deleting text (by holding down the “Delete” key), if you feel the Macintosh is
not being responsive, change the Keyboard settings.

Don't:

While typing, if you press a key and see it appear several times across the line or if
you find yourself repeatedly pressing the “Delete” key, because holding down this
key is too slow, stop wasting your time and adjust the Keyboard settings.

Explanation:

If you're a slow typist, you may feel that the Macintosh is just too fast for you

— whenever you type, letters are sometimes repeated. If you're a fast typist, you
may feel that it’s faster to repeatedly press the “Delete” key or another key, in order
to quickly accomplish the task.

If either of the above is true, it would be a good idea to adjust the keyboard’s repeat
settings. Here’s how to do it:

1- Pull down the “Apple” menu and choose “System Preferences”.

2 - Click once on the “Keyboard & Mouse” icon.
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3 - Click once on the “Keyboard” Tab, located near the top portion of this dialog
box.
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4 - Change the sliders in the “Key Repeat Rate” and “Delay Until Repeat” sec-
tions.

“Key Repeat Rate” is the setting for how fast any key will repeat, after its held
down.

“Delay Until Repeat” is the setting for how long it will take for a key to start repeat-
ing, once it IS held down.
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Comments:
Whenever you're typing and working with repeating keys, such as the “Delete” key,
if the repeating action is too fast or too slow, simply adjust it.



8d- Catalog Your Backups
Do:

When backing up your data to a CD, DVD or even another hard drive make a cata-
log of the contents.

Don't:

If you're backing up your data to a CD (or DVD) don’t write the names of those files
on the CD itself — there may not be enough room and you’ll waste a lot of time in
the future reading each CD trying to locate the information you’re looking for.

Explanation:

When I first started backing up my important information, I would place the files
for one project (say a newsletter) on one CD. I would then label that CD with the
name of that project. I would also type up the names of those files, print it out and
put it in the CD’s case.

Some people may divide their backups by placing backed-up eMails on one CD,
documents they create on another and their photos on yet another.

No matter which way you organize your backups it can be a nightmare when it
comes time to locate a specific item.

Once I realized I could have the Macintosh keep track of which files are stored on
which CD, my backup method became a lot easier to do and faster to implement.
Here’s how I did it... I visited the “VersionTracker” website (www.versiontracker.
com) and searched for the word “catalog”. I found several programs and tested
them all. The one program I settled on is called “CDFinder” (cdfinder.de). It’s easy
to use, does a thorough job and can keep track of any files on any media.

&

&

CDFinder
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Now I use this method for backing up:

1_
2 -

In my “Home” folder, I created a folder called “Back This Up”.

Throughout the day, whenever I create, download or otherwise encounter an
important file, I put a copy in this folder. (If I don’t need to keep a copy on the
hard drive then I put the original in this folder.)

After 30-days, or whenever I have a lot of items in this folder, I insert a CD

or DVD and copy the contents of this folder to that disc. I also copy the “CD-
Finder Database” folder to this disc and name the disc “Backup” and the date.
(Backing up those CDFinder files at this point will backup all the discs I have
cataloged with this program — except this one, because it hasn’t been created
yet. However, during my next backup, I will backup that folder again and it
will include today’s disc catalog.)

Once the disc is “burned” (created) I then open “CDFinder” and have it cata-
log the disc. (This produces a file containing the entire contents of that disc.
This file is automatically stored in your Documents folder.)
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5- When all of that is done, I go into my “Back This Up” folder and Trash all the
items inside. I leave the folder so I can use it for my next backup.

Now, anytime I need to locate a specific file or if I just want to know what is stored
on a certain disc, I open CDFinder and ALL of my backups are right there. Because
of this not only will I save time and not have to read long lists of typed information
but I can simply back up any and all files to one disc — even if they're not related. It
doesn’t matter because I can now find anything I'm looking for. (Of course, it helps
to have good habits of naming your files so you can easily tell what’s inside and

it’s also a good idea to create folders and sub-folders to categorize your files when
initially storing them.)

Comments:

When you discover a task which requires a lot of steps or if you're just having
trouble getting the Macintosh to perform certain functions, take a step back and
see if there’s some way the Macintosh can actually help you do something in a more
efficient way or can help you find the answer to a specific problem. You might be
surprised.

In the case of “cataloging” programs, most of them are “shareware”. Which means
you can “try before you buy”. If you want to research them yourself, be sure they
can perform all the necessary functions and can do it in an efficient manner. Also,
make sure the program you choose is not going to damage or erase your real files.
One of the programs I tried, “DiskTracker”, actually erased my files! I contacted
the company and was told this is a “feature” not a “flaw”. I've been very happy with
CDFinder ever since.
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9a- Don't Interrupt A Working Macintosh

Do:
Sometimes it’s a good idea to let your Macintosh finish one task before giving it
another.

Don't:

Performing a maintenance procedure on your Macintosh, such as “Repair Permis-
sions” or installing a program, while transferring lots of documents, is not a wise
thing to do.

Explanation:

Although the Macintosh Operating System is “multi-tasking” (can keep track of
more than one task at a time, and because your Macintosh may have more than
one CPU (Central Processing Unit, or “brain”), some tasks are handled better if you
don’t activate another function at the same time.

Sure, under normal use you can download more than one file at a time, send eMail
to lots of addresses all at once, copy folder after folder to a disk without waiting
for each task to be completed. You can even do all of these things together AND
browse the Internet while printing documents.

Let’s say you're downloading a very large file from the Internet and, even though
you may have a “fast” high-speed connection, this particular download is chugging
along very slowly. Maybe it will take an hour or more. You may not want to down-
load anything else until this has finished.

« If you download more than one file at the same time, the Macintosh has to
keep track of where each file’s data must be stored. Let’s say you are down-
loading 5 files at once. Your Macintosh creates 5 new files (similar to boxes).
Your Macintosh then notifies the “Server” (the Internet computer where one
of these files is stored) and requests a handful of data. (The size of this “hand-
ful” depends on how many “bits per second” (bps) this file is currently being
transferred at — and this can change during the download process.) Once the
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Macintosh has this data, it stores it in one of those files (boxes). It then goes
back and requests data for the same or another one of those files. All of this
goes on at computer speed and if the Macintosh receives fluctuating electric-
ity or if another program or process interferes with this download or if the
Macintosh Operating System has a glitch in it, one or more of these down-
loaded files may be corrupted (mixed up). If this happens, you probably won’t
know about it until the file is download and you try to use it.

NOTE: This is just a “worst case scenario” which I wanted you to be aware
of, in those times when you must download a file correctly the first
time.

« Another example... If you're burning a CD or DVD of some very important
information, you may want to let your Macintosh complete this task before
emptying the Trash, connecting a Flash Drive or camera, etc. As with the pre-
vious example, if this process is interrupted, directly by you or indirectly by a
behind-the-scenes activity, one or more items copied to that CD or DVD may
be corrupted.

« If your Macintosh is in the process of “Repairing Permissions” and you con-
tinue to perform other tasks, such as download files from the Internet or copy
files to the hard drive, from a CD, the permissions on these items may not
be checked. Waiting until the entire Repair Permission process is complete
would ensure better reliability.

Yes, the Macintosh is designed to “multi-task” and to take care of itself. I'm only
mentioning those critical times when you're saying “I’d better not lose this infor-
mation”. That’s when it might be wise to slow down a bit and give the Mac a chance
to breathe. Waiting an extra few seconds or even a few minutes may help your
Macintosh be more solid in its processes and could result in a faster completion of
tasks for you overall.

Comments:
Even with a multi-tasking Operating System and more than one CPU, it’s some-
times wise to give the Macintosh a little breathing room.



9b- Trim The Size Of Applications

Do:
To free up some hard drive space, remove any languages a program may have in-
stalled, which you are not using.

Don't:
If you need just a little more hard drive space, you may not have to resort to remov-
ing those important files and programs from your hard drive.

Explanation:

When installing Mac OS X “Tiger” (10.4), at one point you are asked to indicate
which language you want the Macintosh to use for all of its menus, dialog boxes,
etc. This becomes the “main” or “default” language for that Macintosh.

Some of the newer programs, especially the ones from Apple (such as those within
“iLife” and “iWork”), contain several languages. They are there in case you want
that particular program to function in a language which is different from the main
language of the Operating System. However, if you don’t want to have your Ma-
cintosh work in one language (say English) and be able to have a single program
(such as iTunes) work in a different language (say Spanish), then you can remove
those extra languages from all your programs. Removing all the languages your
Macintosh is not using, can free up around 1.5GB — that’s “gigabytes” of hard drive
space! Here’s how to do it:

1- Open the “Applications” folder.

2 - Click once on a program’s icon.
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3 - Pull down the “File” menu and choose “Get Info”.
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Trim The Size Of Applications - 9b

4 - Near the bottom of the dialog box that appears, you'll see a section called
“Languages:”. If the triangle, located to the left of this word, is pointing to the
right, click it once and it will point downward, exposing its contents.

5- Although you can click each language you’re not using and then click the “Re-
move...” button, there is a faster way. Click once on any language in this list
— even the one you're using is OK to click on.
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6 - Pull down the “Edit” menu and choose “Select All”.

7 - Now, hold down the Command key and click once on the language your Ma-
cintosh is using. (Sometimes the entry for “English” is labeled as “en”.) This
will de-select that language and the rest of the items in this list will be high-
lighted.
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8 - Click once on the “Remove...” button and then indicate that it’s OK to remove
those languages.

Are you sure you want to move these 13 items to
the Trash?

‘ The application may stop working if you remove these files.

(_: Cancel j} ( Continue |

NOTE: The alert box that appears will warn you that this action “may”
cause that program to stop working or not work properly. If you
want to be cautious about this, after Step 2 above, pull down the
“File” menu and choose “Duplicate”. This will make an exact copy
of that program and you can continue with the above steps using
THAT version. If anything does go wrong, you can Trash this dupli-
cate and still use the unaltered original.
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I've tested the above steps on my Macintosh, without making any duplicates, and
not only did I free up 1.5GB of hard drive space but I didn’t have any problems us-
ing those programs after removing the extra languages.

Comments:

Sometimes there is extra information on your hard drive which your Macintosh
will never use. If you know where to find it and follow reliable steps on how to re-
move those items, you can save some hard drive space and maybe even make your
programs, and your Macintosh, more efficient.
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Alias:
o —— L\
. | - . |
” ' p— b =
Notes.rtf Book Images Preview

An item which is not real. Typically, this applies to all the icons in the Dock. It can
also apply to icons found in the Finder — documents, folders, programs, etc. To
check if an item is an alias, see if there is a tiny arrow in the bottom-left corner of
its icon. The most reliable way to tell is to click the item once, pull down the “File”
menu and choose “Get Info”. In the “General” part of this dialog box, if the word
“Alias” appears, this item is not real. Whenever you activate an alias (by clicking or
double-clicking on it, depending on whether it’s in the Dock, Sidebar or somewhere
else), its only job is to tell the Operating System where the original (real) item is
stored. At that point, the “real” item is used.

NOTE: The items in the Dock and Sidebar are also aliases. However, these
do not have any identifying characteristics.

Application menu:

When you're in the "Finder”,
you'll see this "Application” menu.

@ Finder File Edit View Go Window Help

When you're in the "Mail",
you'll see this "Application” menu.

@ Mail File Edit View Mailbox Message F
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Named this way because whichever program (or the “Finder”) you are CUR-
RENTLY using, will have its name in the menu which is located just to the right of
the Apple menu (top-left corner of the screen). Any time you change programs, the
“Application” menu name will change to that program’s name.

Blinking Insertion Point:

806 Untitled

Styles  Iw) (BET 3 == 3 Spacing i) [ Lists  I9) R EE)
3 U] T I et VIR i e Iy JOTes Soen WL
i B FERE AERe SR MRS PEASAGAS MR AE s Mo

This is what the Blinking Insertion Point
looks like, when you're in TextEdit.

This is the vertical, slowly-pulsing, black line which can only be seen in places
where text can be entered. Usually, you have to click within a text box to see it but

some programs and web pages will sometimes place the Insertion Point in a certain
text box for your convenience.
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Clipping:
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Drag the highligted
text to the Des (oF
and a "Clipping"” file
will appear.

Desktop

The file which is created when text or a graphic is dragged from its document win-
dow (such as TextEdit) or from a web page (such as a Safari window) to the Desk-
top.

Cursor:

The Cursor is on the letter Z in the line below.
Tomorrow we can visit the Boo.

The character-sized rectangle or underline within a block-based text area. The Cur-
sor moves ON or below characters (not between them) and indicates where a letter,
number, space, etc. will be entered or erased. The Cursor is moved by using the
mouse or the Arrow keys (Up, Down, Left, Right).
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NOTE: Some authors incorrectly refer to the Pointer as a “Cursor”. (see

“Pointer”.)
Default:
Settingt.  Page Attributes rﬂ
Format for.  Any Primter a

Paper Size. QS Letter

&

A% nx1100

Ocienation: m fee T

Scale: 100;

U, |_Cancel (- “_)

A setting, or choice, made at the factory. A preselected option. If no other choice is
made by the user, the default setting will be used. Example: If you want to print on

Legal paper (8.5 x 14-inch), you must first change the default Letter paper setting
(8.5 x 11-inch), in “Page Setup...”.
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Desktop:

[ & Fnder fie (ot View Go Window teip + Mzl @ ]

" 3 |
@ =-
®
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3 /

b AN I 7/
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g=== All of this white space is the "Desktop” =)

v | N\

=

&

e

The large background you see when all programs have been Quit and you are in the
Finder. The Desktop is part of your Home.



Dialog Box:

Coples: Ix._ | ¥ Collated
Pages ® A
O from: 1 toc )
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Typically a small window, where you can make choices in a program or for a func-
tion (such as printing).
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Disclosure Triangle

| List View Scroll Test
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This is a ‘Dliclosure Trlangle'. which is
"Open”, because it's pointing downward.
Its contents are indented below it.

This gray bar represents a Label-colored
folder, which is NOT highlighted.

This round circle represents a Label-colored
folder, which is also highlighted (selected).

In list view, the triangle, located to the left of a folder’s icon is called the “Disclo-
sure Triangle”. Clicking it will “reveal” or “hide” that folder’s contents. (The Disclo-
sure Triangle is a toggle. If the triangle is pointing to the right, the contents of that
folder are hidden. If the triangle is pointing downward, its contents are revealed
and can be seen indented below it.
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Dock:

[ @ Fnder i Tt View Go Window Help ¢ Mz @ ]
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M smmen w0
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®

.

L I

The bar of icons which can be found along the left, right or bottom-edge of the
screen. The Dock allows quick-access to any item it contains. You can drag any
document, folder, program or web link to the Dock and it will automatically create
an “alias” of that item.
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Drag:

1 « Place the Pointer
over this icon

g CTED

2 - Hold down the
& mouse button and
then move the mouse.
This is known as

“dragging”.

A mouse action. When the mouse button is held down and then the mouse is
moved. A “Drag” is usually used to move objects (folders, files, graphics items
within a drawing program, etc.) to a different location. For example, you would

“Drag” in order to move a folder to the Trash Can icon in the Dock, if you wanted to
delete (erase) it.



Exposé:

~ the Exposé keysm —
CELLITLLT] 1] L EEEL

. 1

-

Courtesy of Apple

This is an Operating System feature which allows you to:
« View all the currently-open windows at once, by pressing “Fg”.
« View all the currently-open windows of the current program, by pressing
“Fl O”.

« Hide all windows so the Desktop can be seen, by pressing “F11”.

Finder:

- @ Finder File Edit View Go Window Help

Part of the Operating System. The Finder allows you to visually access just about
everything on your Macintosh — including programs, CDs, hard drives, documents,
folders, etc.

6raphic Clipping:

(See “Clipping”)
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Home:

A folder where the user can store and organize their documents, pictures, music,

movies, etc. Mac OS X has already created these folders inside your Home folder.
Although you don’t have to keep photos in the “Pictures” folder, in doing so, you

would be storing all your photos in a single folder because this is the same folder
“iPhoto” uses for storage.



Modifier Keys:

T TEE

A

Command keys == Courtesy of Apple
Option keys e
Shift keys )|

Control keys

The “Command” (or “Apple”), “Shift”, “Option” and “Control” keys are known as
Modifier keys. Holding down one or more of these keys, and using the mouse but-
ton, in various pieces of Macintosh software, can sometimes provide shortcuts or
added features to whatever you are doing.

Operating System:

Software which directly controls the hardware in a computer. We interact with the
Operating System through the Finder and all of this software provides us with the
“Macintosh experience”.

Pointer:

A

The small, on-screen object, typically an arrow, which moves whenever the mouse
is moved. The Pointer is the location where an action will take place. Sometimes
the mouse button has to be held down (to pull down a menu, for example) for an
action to occur. The Pointer’s appearance can change (arrow, i-beam, plus sign,
etc.), depending on the function it’s performing.



NOTE: Some authors incorrectly refer to the Pointer as a “Cursor”. (see
“Cursor”.)

RAM:

Random Access Memory. This is a computer’s “temporary workspace”. In a com-
puter, lots of behind-the-scenes work is done in RAM. The images on the screen
(folders, windows, icons, etc.), are being displayed on the computer’s screen from
RAM. Everything typed on a keyboard is stored in RAM. In order for information
to be available the next time the computer restarts, it must first be saved to the
hard drive. (The folders, windows, icons, etc., are stored on the hard drive auto-
matically but they’re not stored in the same form as seen on the screen.)

Screen:

The part of the computer which displays images. Also referred to as a Monitor and
Display.



Sidebar:

Sidebar

The section of a Finder window which appears down its left side. The items which
are listed are aliases (not real) and are there for quick access. You can remove

or add-to items in this section by dragging them. (When you drag an item out of
the Sidebar, because it’s an “alias”, only that item is deleted. The original is not
harmed.)
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Tab (referring to Safari):

.O h!tp Ilhomepage mac. com/macosmosl -~

‘U“

This Tab is Clicking this Tab will
showing the display an unseen page
current page

A part of Safari (Apple’s web browser) which holds a web page. If there is more
than one Tab in a Safari window, clicking a Tab will reveal its page and hide any
other Tab-based pages within that same window.

Text Clipping:

(See “Clipping”)



Titlebar:

The upper-most part of a window which contains the name of that document
(when you're in a program) or the name of a folder (when you’re in the Finder).
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Toolbar:
The "Action™ menu

program or

document  pocuments

to the

. Toolbar for

u quick
access.

Toolbar

The "Tooolbar”
toggle button

In the Finder, it’s the section of buttons and menu located across the top of each
window.

NOTE: If you don’t see this section, click once on the Toolbar toggle button,
located in the upper-right corner of every standard Finder window.

The Toolbar allows you to add your own quick-access files, folder and programs.
Just drag any of these items to the gray area just between the Action menu and
the Search field. (You may have to hold it there a second or two before you see any
feedback. At that point, you can release the mouse button and an alias of the item
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you were dragging will appear in that spot.) This item will now appear in the Tool-
bar of every “Finder” window. The Toolbar provides quick and convenient access to
any item it holds.



Paul Rego was on a music career path until he innocently became lured into Ap-
ple’s world in 1981 when he saw a music keyboard displayed in the window of an
Apple retailer! By a chain of events, he has gained invaluable experiences leading
to the present. He became experienced in the following:

« Programming (Apple ][, Apple /// and Macintosh),

« Page design and layout,

» Technical support by phone,

» Beta tested a few Apple ][ and Macintosh programs before they were released to
the general public.

« In-person sales demos — he was the Asheville, North Carolina “Apple Mass-Mar-
ket Rep.” for several years and

« Over the years, he has self-published a few Apple ][ and Macintosh books (no
longer in print).

In 1981, he started Insight Data — a Macintosh-only training, troubleshooting and
consulting business, moving to Asheville in 1993. He and his wife Sylvia still play
music together, but most of their time is consumed by volunteer work in M.A.C.S.
(Macintosh Asheville Computer Society, an Apple User Group) and the world of
Macintosh.

Details of Paul’s background can be found on his company website:

http://homepage.mac.com/macosmos



An instructional book should be as educational as possible. Because Macintosh users enjoy
sharing what they know, we think a colophon is important. We wish more publishers
would include it in each of their books.

Tools

« Computer used for everything: iMac G5 with Mac OS X 10.4.7. We wouldn’t trust book
publishing, or ANY computer task, to any computer but a MACINTOSH!

« Software used for page-layout: Adobe® InDesign® CS 3.

« Software used for graphics and the front and back cover: Macromedia Fireworks MX
2004 (version 7). When adding images to these pages, we wanted to be sure you could
see what they are illustrating and could read the text. Because of this, we made each
image as large as possible. Their sizes may not be consistent with each other but at least
they’re easier to read.

Table Of Contents

« Title: Font: Papyrus, 36-point with 43.2-point (auto) leading.

« Secondary Titles = Font: Comic Sans, 16-point with 16-point leading.

« Page Numbers = Font: Comic Sans bold, 36-point with 16-point leading, -11-point Base-
line Shift, 30% black.

Efficiency Chapter Pages:
 Large number or letter = Font: Comic Sans bold, 400-point, 480-point (auto) leading,
20% black.

Efficiency Sections

« Page Titles (top-left) = Font: Comic Sans bold, 20-point with 24-point (auto) leading,
50% black.

« Page Numbers = Font: Comic Sans bold, 24-point with 28.8-point (auto) leading, 50%
black.

« Wavy, top-of-page line = 10-point line from InDesign’s Stroke palette, 15% black.

« Secondary Titles (Do, Don’t Explanation, Comments) = Font: Comic Sans bold, 14-point
with 17-point leading.

» Body Text = Font: Georgia, 12-point with 16-point leading.

BonusTips

When the entire book was finished, we noticed 14 blank pages. Because we don’t think
our readers should pay for empty pages, we looked at this as an opportunity to add even
more information but instead of adding more “Efficiencies”, which require extra pages, we
thought we’d surprise you by adding 14 “Tips”! They may be short but they’re still impor-
tant.



A

Adding bookmarks to Safari. See BonusTip: Using Safari’s Bookmarks
Alias. See BonusTip: Understanding Mac OS X

Apple training. See BonusTip: Other Instructional Resources
Applications - trimming the size of 188

Application menu 6, 40, 140, 141, 199

Application Switcher 10

B
Backups - organizing 182
BonusTip
Adding Icons To The Toolbar 33
Add TextEdit And Preview To The Dock 95
Avoiding More Suspicious eMail 139
Having The Mac Automatically Open Programs 177
Join A Macintosh User’s Group 9
Look At The Big Picture When Problem Solving 47
Other Instructional Resources 168
Protect Your Mac From Bad Electricity 152
Reading Small Text 157
Searching With Spotlight 23
Understanding Mac OS X 105
Use Font Book To Trim Down Your Fonts 29
Using Safari’s Bookmarks 116
Bookmarks. See BonusTip: Using Safari’s Bookmarks
Bookmarks menu. See BonusTip: Using Safari’s Bookmarks

C
Catalogers 182
Chart
Finger placement for typing 14
Mouse clicks - what they mean 18
“Save” alert box - corresponding keys 16
Colored Text 38
Column View 106
Combo Update. See BonusTip: Look At The Big Picture...
Command key 7, 8, 50. See also Image: Keys: Command key
Command key symbol. See Image: Keys: Command key
Contextual menus 96
Control. See Modifier keys

D

Desktop

Seeing more of it 64
Divider Bar in Mail. See BonusTip: Avoiding More Suspicious eMail
Dock 33

Hiding 66



Locating an original item 68
Placement 64

E

Electricity. See BonusTip: Protect Your Mac From Bad Electricity
Exposé 76
Exposé keys 76. See also Image: Exposé keys

F10 - show program windows 76

F11 - reveal the Desktop 77

F9 - show every window 76

F
Folder

Dragging items to a folder 154
Font Book. See BonusTip: Use Font Book To Trim Down Your Fonts

6

Glossary
Alias 198
Application menu 198
Blinking Insertion Point 199
Clipping 200
Cursor 200
Default 201
Desktop 202
Dialog Box 203
Disclosure Triangle 204
Dock 205
Drag 206
Exposé 207
Finder 207
Home 208
Modifier Keys 209
Operating System 209
Pointer 209
RAM 210
Screen 210
Sidebar 211
Tab - Safari 212
Titlebar 213
Toolbar 214

H

habit
Aim for the gray part of the Titlebar 61,79
Always aim for the largest target 28, 156
Checking for new web page content 59
Click to select words, lines & paragraphs 19



Closing windows versus quitting programs 140
Command-clicking a Finder window 81
Enter fewer letters in the search field 23
Familiarize yourself with a window’s components 83
Fast drag-scroll technique 87
Icon View - drag across items to select them 113
Make Text Clippings 130
Minimize window to save time 71
Pause before dragging text 132
Selecting objects 134
Start dragging from the upper-left 115, 135, 138
Stop when something goes wrong 12
Use Exposé to quickly find open windows 77
Use the screenshot feature 129
Hard Drive noise. See BonusTip: Look At The Big Picture When Problem Solving
Hierarchy of a folder 81
Highlighting Text
Changing the highlight color 39
Large areas 34
with the Arrow keys 30
Highlight Color 39
Home folder. See BonusTip: Understanding Mac OS X
Home Row. See Typing: Home Row

I

Icon View 112
Separating cluttered items 158

Image
Action menu - in Finder windows 214
Alias 198
Appearance - System Preferences 119
Application menu 141, 198
Application Switcher 11
Blinking Insertion Point 199
Bookmarks, Show All 116
CDFinder screenshot 183
Close button, red 70, 72, 92, 140

On unsaved documents 93

Column View button 99, 107
Contextual menu 96
Cursor 199. See also Image: Pointer
Desktop 202
Disclosure Triangle 103, 204
Divider Bar 139
Dock 205
Dock icon menu 68, 143
Dock menu 64, 66



Document icon in its window 93
Dragging 206
Exposé keys 207
Favicon 26
Finder icon 158, 161
Folder icon - in a Finder window 90
Forward/Back buttons - Safari 46
Get Info dialog box 190, 192, 193, 195
Get Info option 189
Google search field - Safari 62
Highlight color 39
History menu - Safari 45
Home folder 208
Home position for typing 15
Icon View button 99, 107
Insertion Point. See Image: Blinking Insertion Point
Keyboard, Command keys 7
Keyboard symbols 8
Keys
Caps Lock key symbol 8
Command key 125, 126, 127, 142, 209. See also Command key
Command key symbol 7, 8
Control key 209
Control key symbol 8
Delete key symbol 8
Enter key symbol 8
Escape 12, 76
Escape key symbol 8
Fio0 76
F11 76
Fg9 76
Option key 209
Return 12
Return key symbol 8
Shift 125, 126, 127, 209
Shift key symbol 8
Spacebar 12
Left hand / Right hand placement 16
List View button 99, 107
Minimize button, yellow 70, 72, 140
Picture 1 - screenshot file 125, 126, 128
Pointer 209. See also Image: Cursor
Preferences - Safari 49
Print dialog box 203
Progress Bar 144



Reload button - Safari 57
Resize Box 85
Resize button, green 70, 72, 140
Save alert box 11
“Save As” dialog box - collapsed 148
“Save As” dialog box - expanded 149
Screenshot keys 125, 126, 127
Camera activation / Window option 128
Scroll Arrows 85, 120
Scroll Bar 54, 85, 120, 122, 123
Scroll Box 35, 85, 99, 107, 120, 122, 123
Searching within the Save As dialog box 150
Search Field 147
Select All option 101, 109, 115, 137, 192
Services menu 40
Show View Options menu 163, 166
Sidebar 89, 211
SnapBack button - Safari 44
Status Bar - Safari 50
Status Bar option - Safari 50
Switching programs with Application Switcher 11
System Preferences
Keyboard & Mouse 171, 179
Keyboard settings 180
Mouse settings 172
Universal Access 175
Cursor (Pointer) Size 176
Tabs - Safari 49, 212
TextEdit - default styles 41
Titlebar 53, 59, 74, 78, 213
Toolbar 33, 89, 214
Toolbar Toggle button 214
Trash alert box 194
Universal Access 42
URL field - Safari 44,58
View menu - Arrange By... 160, 167
Window’s menu - document 82
Window’s menu - Finder 81

K

Keep Arranged By 158

Keyboard delay speed 178
Keyboard symbols. See Image: Keys
Keystroke 8

L
List View 98



Login Items. See BonusTip: Having The Mac Automatically Open Programs

M

Macintosh - interrupting when working 186
Mac OS 9. See BonusTip: Understanding Mac OS X
Mail

Mail text size. See BonusTip: Reading Small Text
Modifier keys 3, 209
Mouse speed 170

O

Option key. See Modifier keys
Option key symbol. See Image: Keys: Option key
Organizing your icons. See BonusTip: Adding Icons To The Toolbar

P

Pointer - setting its size 174
Preview. See BonusTip: Add TextEdit And Preview To The Dock
Programs
Close or Quit? 140
Progress Bar 144

S

Safari 4, 6, 7, 26, 27, 37, 45, 46, 51, 53, 55, 58, 116, 200, 212.
See also BonusTip: Using Safari’s Bookmarks
Back/Forward buttons 44
Checking for new content 56
Google search 62
Organizing windows 48
Safari text size. See BonusTip: Reading Small Text
Status Bar 50
Tabs 49
Windows 52
Switching 60
“Save” alert box 10
“Save As” dialog box 149
Screenshot 124
Scrolling
Three ways 118
search, How to. See BonusTip: Searching With Spotlight
While in the “Open” dialog box 146
While in the Save As dialog box 146
Selecting
Items in Column View 106
Items in Icon View 112
Items in List View 98
Objects 134
Selection Box 134



Settings

Remembering for future use 124
Shift key. See Modifier keys; See also Image: Keys: Shift

Shift key symbol. See Image: Keys: Shift
Spotlight 23, 83, 149
Startup screen colors. See BonusTip: Look At The Big Picture...
surge protector. See BonusTip: Protect Your Mac From Bad Electricity
Suspicious eMail. See BonusTip: Avoiding More Suspicious eMail
Symbols for common keys 8
System Preferences 38, 42, 118, 171, 174, 178.

See also BonusTip: Having The Mac Automatically Open Programs

T
Text
Clippings 130
Colored 38
Highlight with the Arrow keys 30
Replace highlighted with typing 20, 24
Selecting text 18
Size. See BonusTip: Reading Small Text
TextEdit. See BonusTip: Add TextEdit And Preview To The Dock
Titlebar
Icon - in various applications 92
Icon - relocating a folder 88
Toolbar 89. See also BonusTip: Adding Icons To The Toolbar
Training. See BonusTip: Other Instructional Resources
Troubleshooting. See BonusTip: Look At The Big Picture When Problem Solving
Typeface 29, 157
Typing
Home Row 14
)

UPS (Uninterruptible Power Supply). 152
USB hub. See BonusTip: Look At The Big Picture When Problem Solving

w
Window
Bringing to the front 72
Closing 70
Drag speed 84
Jumping to a document’s folder 82
Jumping to a window’s folder 80
Minimizing 70
Multiple windows, working with 74
Scrolling - three ways 118
Seeing all at once 76
Switching to the one behind 78
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